Phaser 540 Plus

The Phaser® 540 Plus Color Printer is Tektronix’ second generation

color laser printer. This addendum supplements the Phaser 540 Drivers and
Utilities Printing Reference (070-9009-00).

In most cases, the information contained in the Phaser 540 Drivers and Utilities
Printing Reference is applicable for use with Phaser 540 Plus color printers.
Phaser 540 Plus printer driver differences are detailed in this addendum.

The Phaser 540 Plus drivers and utilities provide support for the following
new printer features:

= Legal-size printing capability

= Anew Presentation print-quality mode
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Phaser 540 Plus

General differences

The default printer name that appears in dialog boxes and
windows changes to Phaser 540 Plus.

A Presentation print-quality mode has been added for creating
presentation materials such as overhead transparencies and
presentation handouts with a color sweep in the background. The
Presentation print-quality mode appears as a front panel selection,
a driver selection, and a downloadable utility.

Macintosh utility Presentation Quality
Macintosh QuickDraw GX Printer utility Use Presentation Quality
PC Windows utility PRESENTN.PS

The default print-quality mode for the printer changes to Fast. The
default print-quality mode for the drivers remains Standard. This
provides faster throughput when selecting Fast mode from the
driver.

When you select a print-quality mode, printer output is dependent
on the amount of installed memory and the paper size. For
example, if the printer has 20 Mbytes of memory and you select
Enhanced for Letter-size paper, the printer uses the Standard
print-quality mode. Refer to the following table for details.

Installed memory

Print-quality selection  Letter/A4-size paper  Legal-size paper

Standard 20 Mbytes Fast Fast Fast
Standard Standard Fast
Presentation Presentation Fast
Enhanced Standard Fast

One 16-Mbyte SIMM Fast Fast

36 Mbytes total .

( y ) Standard As selected in Standard

- the driver .

Presentation Presentation
Enhanced Standard

Two 16-Mbyte SIMMs  As selected in As selected in As selected in

(52 Mbytes total) the driver the driver the driver
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Phaser 540 Plus

Diskette contents changes

Some seldom-used and obsoleted files have been removed from the
Phaser 540 Plus driver and utilities diskettes.

= \ersion 3.0 PPD and PDX files have been removed from the
Macintosh Driver and Printer Utilities diskette and the Windows
3.1 Driver and Printer Utilities diskette. If needed, you can obtain
copies of these files from the Tektronix Bulletin Board Service (BBS).

= WPD files have been removed from the Windows 3.1 Driver and
Printer Utilities diskette. These files are used to update the
standard Microsoft Windows PostScript driver in your system
folder. You can obtain copies of these files from the Tektronix
Bulletin Board Service (BBS).

= The AppleTalk Installer on AppleTalk Installer for the Macintosh
diskette is a newer version than described in the manual. See the
README file for details.

= The Set EtherTalk Zone utility on the Macintosh Driver and Printer
Utilities diskette and ETHRZONE.PS utility on the Windows 3.1
Driver and Printer Utilities diskette have been removed. These
utilities are now included on the Network Utilities diskette shipped
with PhaserShare™ cards.

= Two new downloadable utilities are included on Phaser 540 Plus
drivers and utilities diskettes to control job pipelining. The default
setting is Pipelining Off.

Macintosh utility Pipelining On
Pipelining Off

Macintosh QuickDraw GX Printer utility Enable Job Pipelining
Disable Job Pipelining

PC Windows utility PIPE_ON.PS
PIPE_OFF.PS
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Phaser 540 Plus

File/directory name changes

4

Macintosh changes

Macintosh: The Print and Page Setup dialog box names change to
Phaser 540 Plus.

Compressed archive files on the Macintosh Driver and Printer
Utilities diskette change to: Phaser 540P Apps.sea, Phaser 540P
Samplers.sea, and Phaser 540P Utilities.sea

The PostScript Printer Description (PPD) file used with the
LaserWriter 8.x printer driver, Aldus PageMaker 5.0 and Aldus
Freehand 4.0 changes to TKP540P1.PPD.

The QuarkExpress printer description file changes to
Phaser 540P.PDF.

The printer driver used with QuickDraw GX applications changes
to Phaser 540 Plus GX.

PC changes

Windows: The Printer Setup dialog box nhame changes to
Phaser 540 Plus.

The Utility file directory on the Windows 3.1 Driver and Printer
Utilities diskette changes to PHSR540P.

The PostScript Printer Description (PPD) file used with Aldus
PageMaker 5.0 and Aldus Freehand 4.0 changes to TKP540P1.PPD.

The Tek Phaser 540 Plus (TekColor) printer name now appears in
the Add Unlisted or Updated Printer window.

The QuarkExpress printer description file changes to
TKP540P1.PDF.
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Legal-size printing

Phaser 540 Plus

The Phaser 540 Plus drivers contain new Legal and Legal Short-size driver
selections. The printable area used by an application is determined by
selecting Legal or Legal Short in the driver (the physical page size is the
same for both; only the print area is different).

= Legal Short

Prints a full-color image (8.2 x 11.7 in.) on legal-size paper with
top and bottom margins of 1.15 in.

s Legal

Prints a full-color image area the same as Legal Short, but can also
print monochrome with top and bottom margins of .23 in.

Margins
Media Page size Print area Top Bottom  Sides
1. AlLetter (U.S.) 8.5x11in. 8.2x10.6in. 22in. .18 in. A5in.
2. A4 (Metric) 210 x 297 mm 200 x 287 mm 5 mm 5 mm 5 mm
3. Legal Short 8.5x 14 in. 8.2x11.7 in. 1.15in. 1.15in. .15in.
(u.s.) (CMYK)
4. Legal (U.S.) 8.5x 14 in. Color (CMYK)
8.2x11.7in. 1.15in. 1.15in. .15in.
Black (K)
8.2x13.5in. .23in. .23in. .15n.
1 2 3 4
I
——82in.—— ——— 200 mm — : :
10.6in. 287 mm P 0.2 10 Bl | S 0.2 10
11.7in. 11.7 in.
CMYK CMYK
I
K
8.2x 13.5in.

900Kk-102
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Phaser 540 Plus

Legal Short Driver Selection

The Legal Short driver selection is the simplest driver choice for printing a
legal-size page. Applications that use the page margin information
provided by the Legal Short driver automatically limit the print area to the
center 11.7 inches of the page. Refer to the previous illustration for complete
print area dimensions.

Legal Driver Selection

The Legal driver selection is useful when you want to place black (only)
header or footer information outside the center 11.7-inch area of a legal-size
page. Refer to the previous illustration for complete print area dimensions.

With this driver selection, the application uses a print area of

8.2 x 13.5 inches. Full-color information is printed inside the center

11.7 inches of the page. Outside the center 11.7-inch area, only the black (K)
portion of the image, text, or graphic data is printed.
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Before You Begin

The Phaser 540 color printer lets you easily add color to your documents or
presentations. The drivers and utilities on the diskettes shipped with your
printer are designed to help you get the best printed results.

There are different ways to use the printer’s features. Printer drivers are
available for Macintosh and Windows applications, and downloadable
utility files let you make selections and modify the printer’s behavior. Most
of the features in the drivers and utility files are also available from the
printer’s front panel. Refer to the tables on the following pages for details on
the different ways to use the printer.

Note If you are using a workstation and cannot use the DOS diskette,
refer to “Obtaining the PC utility files” on page 4-8 for
instructions on obtaining the utility files from other sources.
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1 Before You Begin

Using the printer’s features

Tektronix printer drivers

Downloadable utility files

When = Macintosh driver : Use with most » Use to modify the printer, such as changing the
to use Macintosh applications. printer’s name, or downloading the error
= Windows driver : Use with most handler.
Windows applications. = Print the color and font sampler charts.
= For use with applications/platforms that don’t
use the Tektronix drivers.
= For selecting features not available in the
Tektronix drivers.
= When you don’t want to use the printer’s
front panel.
Options/ Driver selections override utility file and Many utility file selections affect all users.
Features front panel selections for prints made from . ) .
the driver = Print a configuration page (see page A-4).
« Select media size = Select media trays (see page 5-5).
(see page 5-2). = Select print quality (see page 5-10).
= Select media trays = Select TekColor color corrections
(see page 5-5). (see page 6-4).
= Select print quality » Reset the printer (see page 9-23).
(see page 5-10). = Use the Tektronix error handler
= Select the output direction: face up or face (see page 9-9).
-14). s .
down (see page 5-14) = Format and initialize a SCSI hard disk
= Select TekColor color corrections (see page B-2 and page B-4).
see page 6-4). .
( Pag ) = Control SysStart jobs (see page B-5).
= Change and test printer language modes
(see page C-4 and page C-6).
= Add or delete Control-D characters
(see page 3-33).
Where = Macintosh driver :Located on the = Macintosh utility files : Located on the
to find Macintosh Driver and Printer Utilities Macintosh Driver and Printer Utilities diskette
diskette (see page 2-3 for installation (see page 2-12 for instructions on
instructions). decompressing and using the files).
= Windows driver : Located on the Windows = PC utility files : Located on the Windows 3.1
3.1 Driver and Printer Utilities diskette (see Driver and Printer Utilities diskette (see page
page 3-4 for installation instructions). 3-26 for instructions on using the files).
1-2 Phaser 540 Drivers and Utilities



Before You Begin 1

Printer’s front panel

When = For use with applications/platforms that don't use
to use the Tektronix drivers.

= For selecting features not available in the Tektronix
drivers.

= For selecting a color adjustment when printing the
color sampler charts.

Options/ Front panel selections affect all prints, except prints
Features made from a Tektronix printer driver.

= Print help pages.

= Obtain system counts.

= Select TekColor color corrections.

= Select print quality.

= Select a language, such as English or Espafiol.
= Change printer defaults.

= Change serial port settings.

= Adjust network settings.

Where Printer’s front panel:  Use the arrow keys and

to find Menu button to use menus. Refer to the
Phaser 540 Color Printer User Manual for
instructions.
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1 Before You Begin

Checking the diskettes

The printer is shipped with the following diskettes. Refer to the table below
to locate information on the contents of a specific folder or directory.

Diskette Folder/Directory Contents Where to find
information
Macintosh Driver and ~ Top (root) level Contains the printer drivers. page 2-1
Printer Utilities
Phaser 540 Apps.sea* Contains printer description files for use page 2-20
with specific applications.
Phaser 540 Samplers.sea* Contains files that print color sampler page 6-12 and
charts and a font sampler. page 7-4
Phaser 540 Utilities.sea* Contains utility files for use with the printer. Chapter 2
Chapter 5
Chapter 6
Appendix A
Appendix B
Appendix C
Phaser Screen Fonts.sea** Contains screen fonts to match the page 7-1
printer’s fonts.
AppleTalk Installer Top (root) level Contains files for updating AppleTalk page 9-8 and
(for the Macintosh) software. page 9-22
Windows 3.1 Driver Top (root) level Contains the files for installing the Tektronix page 3-4
and Printer Utilities Windows 3.1 driver.
WPD Contains files for updating the standard page 3-18
Microsoft Windows PostScript driver for use
with Tektronix printers.
APPLSPEC Contains printer description files for use page 3-35
with specific applications.
PHSR540 Contains utility files for use with the printer. Chapter 3
Chapter 4
Chapter 5
Chapter 6
Appendix A
Appendix B
Appendix C
SAMPLERS Contains files that print color sampler page 6-12 and
charts and a font sampler. page 7-6

* These are compressed archive files; refer to page 2-12 for decompressing instructions.
** This is a compressed archive file; refer to page 7-2 for decompressing instructions.
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Chapter

Printing From a
Macintosh

Using a Tektronix printer driver for the Macintosh

The Macintosh Driver and Printer Utilities diskette includes two Macintosh
printer drivers that allow you to select page sizes, media trays, print quality,
and TekColor color corrections for a Phaser 540 printer.

Phaser 540 driver

The Phaser 540 driver is a Tektronix-modified version of Apple’s
LaserWriter 7.1.2 printer driver.

Use the Phaser 540 driver if you are using System Software 6.0.7,
or 7.0 and later.

If you are using System Software 7.5 and QuickDraw GX, you
must disable QuickDraw GX before using this driver; the
Phaser 540 driver does not work with QuickDraw GX.

The Phaser 540 driver is described in this chapter.

Phaser 540 GX driver

The Phaser 540 GX driver is a Tektronix driver for QuickDraw GX.

Use the Phaser 540 GX driver if you are using System Software 7.5
and QuickDraw GX.

The Phaser 540 GX driver works with QuickDraw GX applications
and with non-QuickDraw GX applications.

The Phaser 540 GX driver is described in Chapter 8, “Using the
Phaser 540 GX Driver.”

Printing Reference
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2 Printing From a Macintosh

System requirements

Note  You must have an optional Phaser Share Card installed in the
printer before installing the driver.

The Phaser 540 printer driver for the Macintosh requires the following
hardware and software:

= An Apple Macintosh Il computer (or later)
= At least 4 Mbytes of memory

= System Software version 6.0.7, or 7.0 and higher

Installing the driver

If the printer is shared on a network, install the same version of the Tektronix
driver on all Macintosh computers connected to the network.

1. Make sure your Macintosh is powered up with System Software
version 6.0.7, or 7.0 or higher, installed.

2. Insert the Macintosh Driver and Printer Utilities diskette into the
disk drive.

3. Drag the Phaser 540 driver icon from the diskette to the closed
System Folder icon on your Macintosh hard disk.

= System 7.0 and higher, at the alert message, click OK to
automatically install the driver in the Extensions folder.

= System 6.0.7, the driver is installed in the System Folder.
4. If you are using system 6.0.7, you need to install two files in the
Old System Items folder:

= Backgrounder V1.3
= PrintMonitor V7.0

Drag these files to the closed System Folder icon on your
Macintosh hard disk.
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5.

6.

7.

Printing From a Macintosh

If you installed the additional software in Step 4, you need to
restart your Macintosh to activate that software.

Store the printer driver diskette in a safe place.

If you want to rename the printer, see page 2-18 for instructions.

Selecting the printer in the Chooser

1.
2.

Select Chooser from the Apple menu.

Click the Phaser 540 printer driver icon located on the left-hand
side of the Chooser.

A list appears with the printers you have connected to your
Macintosh, or printers that are available on a network. (If the
printer driver icon does not appear, Restart your Macintosh, and
repeat the printer driver installation procedure; also check the
cable connections on your computer and printer.)

Click on the Tektronix Phaser 540 printer you want to print to.
The list of Tektronix printers is located on the right side of the
Chooser.

Close the Chooser by clicking its close box.

Printing Reference
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2 Printing From a Macintosh

Using the driver’s options

2-4

Use the Page Setup, Print, and TekColor Options dialog boxes to select
printing options. Refer to other chapters in this manual for instructions on
performing common tasks with the driver.

Applications that use their own drivers

Some Macintosh applications, such as Aldus PageMaker 5.x, do not
recognize settings made using the Tektronix printer driver. For PageMaker
5., use the LaserWriter 8.x printer driver configured with the version 4.x
TKPH5401.PPD printer description file (see “Using the LaserWriter 8.x
printer driver” on page 2-8 for details). The best way to obtain the TekColor
color corrections with this configuration is to use one of the following:

= Color correction utility files — Refer to “Selecting color
corrections” on page 6-7 for instructions.

= Printer’s front panel — Refer to the Phaser 540 Color Printer User
Manual for instructions on using the printer’s front panel.

Extensions to the Print dialog box

Some applications add their own extensions to the Print dialog box. Refer to
the application’s documentation for information on extra options not
described in this manual.

Phaser 540 Drivers and Utilities



Printing From a Macintosh 2

Making selections in the Page Setup dialog box

Choose Page Setup from the File menu to open the Page Setup dialog box.
Make printer selections in the Page Setup dialog box as desired. Most
options are standard LaserWriter driver options.

When selecting a paper size, use the pop-up menu. Refer to the table on
page 5-2 for a list of paper sizes and image areas for your printer.

Fhaser 538 ne (e
Paper: ()5 Lether (848 Lefter
CIWS Leged (8% Letter 9 [ LEtler = | [Cances |
Aeduce g Frimber Effnchs;
Emlprge: [ (=] Fasit Subsiibptiss? Cr
Orienfation [EI WaHA Sl | Ry T
[ Graphics Sy ?
m (= Faster Bifmap Prinfing 7

Making selections in the Print dialog box

Choose Print from the File menu to open the Print dialog box. Make printer
selections in the Print dialog box as desired. Most options are standard
LaserWriter driver options.

Click the TekColor button to see the TekColor Options dialog box.

Phaser 540 “Phaser 540” 712 ||

Eupies:EI Pages: ® Al ) From: To: I:I
Cancel

Cover Page: (® No () First Page O Last Page

Paper Source: (& Paper Cassette () Manual Feed

Print: ) Black & White @ Color/Grayscale

Destination: (@ Printer > PostScript® File TekColor|
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2 Printing From a Macintosh

Making selections in the TekColor Options dialog box

Click the TekColor button in the Print dialog box to open the TekColor
Options dialog box. Make printer selections in the fields described in the
following table. Refer to Chapter 5, “Selecting Media and Image Options,”
and Chapter 6, “Using Color,” for details on these options.

"TekColor Options vz [Cox )
Color Correction: [ Livid Color | (cancel )
Tray Selection: | Paper |
Print Quality: [ Standard |
Manual Feed Media: [ Paper |
[ Output Face Up
TekColor Options dialog box options
Dialog box options  Option description
Color Correction Select one of the following options:
= None = Euroscale Press
= Vivid Color = Commercial Press
= Simulate Display = Monochrome
= SWOP Press = Use Printer Setting
Tray Selection Select one of the following options when Paper Cassette
is selected as the Paper Source in the Print dialog box:
= Upper = Paper
=« Middle = Transparency
= Lower
Print Quality Select one of the following options:
= Fast
= Standard
= Enhanced

Manual Feed Media  Select one of the following options when Manual Feed is
selected as the Paper Source in the Print dialog box:

= Paper
= Transparency

Output Face Up Check this box to stack prints face up in the output tray.
Uncheck this box to stack prints face down in the
output tray.
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Printing From a Macintosh 2

Using the LaserWriter 8.x printer driver

You can use Apple’s LaserWriter driver version 8.x with a Phaser 540 printer.
Some applications, such as Aldus PageMaker 5.x, use the LaserWriter 8.x
driver instead of the Tektronix driver.

Installing the LaserWriter 8.x driver

Note  During installation, the LaserWriter 8.x driver leaves other
versions of the LaserWriter driver intact so that this driver can
co-exist with the Tektronix driver.

Refer to the LaserWriter driver’s documentation, LaserWriter 8.x Update
Guide, for instructions on installing the driver.

Using the LaserWriter 8.x driver with a Phaser 540

The LaserWriter 8.x driver uses printer-specific 4.x PPDs (PostScript Printer
Description files) for information on a printer’s page sizes, printing options,
and media type options. To use the LaserWriter 8.x driver with a Phaser 540
printer, perform the following steps. If the printer is busy, it may take some
time to complete this procedure; you may want to perform it when the
printer is idle. You only have to configure the printer once.

1. The Phaser 540 Apps.sea archive file on the Macintosh Driver and
Printer Utilities diskette contains printer description files for the
printer. Follow the instructions on page 2-12 to decompress these
files, then continue with the steps listed below.

2. Locate the 4.x PPDs Folder in the folder on your hard disk
containing decompressed files.

Open the folder and place the TKPH5401.PPD file with the other
PPDs for the LaserWriter 8.x driver in the Printer Descriptions
folder, in the Extensions folder, inside the System Folder.

3. Open the Chooser.

4. Select the LaserWriter 8.x driver icon.
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5. Select your printer from the list.
6. From the Chooser, click the Setup button to see a list of options.

7. Inthe dialog box that appears, click the More Choices button to
see the full range of options.

Note Do not use the Auto Setup button; errors can occur with the
PPD files. Continue with this procedure to properly set up
the driver.

8. Click the Printer Info button, then click the Update info button in
the next dialog box.

9. Record the information for PostScript Version and Total Memory
Installed; you will need this information later. Click OK.

10. Click the Select PPD button. The Printer Descriptions folder in the
Extensions folder, inside the System Folder, appears.

Sebintl a Postiorgt™ Prinfer Deseription Fie:
|:i Frimler Bescriglipas W |

[T T T T T T 7 R———
O Linofronic 558 w3 -
g TE200172,FPD [ ject |
2005092, PPD T
0 TEPZ2001,PPD [ mesktop |
O TEPZ5E1 7P
01 TEPIOOI,PPO
O TEFH1401,FPD —
0 TEPHA401,PPD o] [V Somer |
O TEPHAE01,PPD
Ol TEFHS401,FFD [T

Frimer MHafek
Tektionii Phaser 568 whii 5ok

11.  Select the TKPH5401.PPD file. Make sure that the information
under Printer Model matches the printer you have and the
PostScript Version information you obtained in Step 9.

12. Click Select.
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Note

13.

14.
15.

16.

17.

Printing From a Macintosh

If the information under Printer Model is not an exact match,
use the closest printer name, and call Tektronix Customer
Support in the U.S. and Canada at 1-800-835-6100 for the latest
PPD file. Outside the U.S. and Canada, contact your local
Tektronix reseller. You can also download the latest PPD files
from the Tektronix Bulletin Board Service (BBS); see page 9-1
for instructions.

Click Configure. In the field for Memory Configuration under
Installable Options, select the amount of memory your printer
has installed. Check other options, either Installed or

Not Installed, as appropriate.

Click OK in two dialog boxes and close the Chooser.

Open the Page Setup dialog box to see a pop-up menu with all the
printer’s supported paper sizes.

Open the Print dialog box to select the paper source.

In the Print dialog box, click the Options button to open the Print
Options dialog box.

Printer-specific TekColor features are listed at bottom of the
dialog box. Refer to Chapter 5, “Selecting Media and Image
Options,” and Chapter 6, “Using Color,” for details on
these options.
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Using the Macintosh utility files

The Macintosh Driver and Printer Utilities diskette contains compressed
archive files with .sea extensions. Each compressed file contains a group of
files. For example, the Phaser 540 Utilities.sea file contains the printer utility
files for performing certain tasks, such as resetting the printer and using the
error handler. You need to decompress an entire archive file onto your hard
disk and then delete the individual files you don’t want to use.

2-10

Phaser 540 Apps.sea contains the printer description files described
on page 2-20.

Phaser 540 Samplers.sea contains the color sampler charts described
on page 6-12, and the font sampler described on page 7-4.

Phaser 540 Utilities.sea contains the utility files described in several
places in this manual.

Phaser Screen Fonts.sea contains the screen fonts described on
page 7-1.
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Decompressing the Macintosh utility files

1.

Insert the Macintosh Driver and Printer Utilities diskette into your
computer’s disk drive.

Double-click on a compressed file with a .sea extension.
At the Self-Extracting Archive dialog box, click Continue.

In the dialog box, select the location, such as your hard drive,
where you want the decompressed files saved.

Imcknali salisssre & et ]

Fapser 540 Uilifiey slder |

At the Install software as: prompt, you are asked to name
the folder where you want the decompressed files saved. Use the
default folder name listed in the edit box or type in the desired
folder name.

Click Save.
At the Installation was successful dialog box, click Quit.

The contents of the decompressed file are saved in the folder you
specified and are ready for use.
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Downloading files to the printer

Note  If you are using System Software 7.5 and QuickDraw GX, you
can also download printer utilities from the Tektronix
Phaser 540 GX printer driver; refer to page 8-13 for instructions.

Using the LaserWriter Utility to download files to the printer

The LaserWriter Utility is an Apple utility you use on the Macintosh to send
PostScript files and fonts to the printer.

LaserWriter Utility version 7.7 is compatible with Apple System Software
versions 7.x. If you are using System Software 6.x, check the Tektronix BBS
for another version of the LaserWriter Utility in the LW_UTIL.SEA
compressed archive file. See page 9-1 for instructions on using the BBS.

=

Laserlriter Utility

Note  You cannot use the LaserWriter Utility if the printer is
connected to a print server. See your system administrator to
temporarily remove the printer from the print server so you can
download the necessary files.

1. Follow the instructions on page 2-12 to decompress the Phaser 540
Utilities.sea archive file on the Macintosh Driver and Printer
Utilities diskette to a folder on your hard disk.

2. Install a Tektronix driver using the instructions on page 2-3
(Phaser 540 driver) or page 8-2 (Phaser 540 GX driver).
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3. Select the appropriate printer in the Chooser.

4. Locate the LaserWriter Utility in the folder of decompressed files.
You may want to place this utility in a Utilities folder, or leave the
utility on your desktop if you use it often.

5. Double-click on the LaserWriter Utility icon to start
the application.

6. Select Download PostScript File from the Utilities menu.
7. Select the file you want to send to the printer and click Open.

8. At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Then click Save
to send the file to the printer. (Printer output includes status
messages generated by the printer to report conditions such as out
of paper.)

9. If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the box to continue.

If output is returned by the printer, you won’t see this dialog box.
Check your hard disk for the file created by the utility for the
printer’s output.

Using the LaserWriter Utility to perform other tasks

In addition to downloading PostScript files and fonts, you can use the
LaserWriter Utility to perform other specialized tasks.

Task Where to find details
Changing the printer's name. page 2-18
Enabling or disabling the printer’s startup page. page A-2

Initializing a formatted SCSI hard disk connected to page B-4
the printer.
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All the files in the following table can be downloaded to the printer using the
LaserWriter Utility:

Downloadable utility files Where to find details

= Fast Quality Chapter 5
= Standard Quality
= Enhanced Quality

= Use Any Tray Chapter 5
= Use Lower Tray
= Use Middle Tray
= Use Upper Tray

= Commercial Press Chapter 6
= Euroscale Press

= SWOP Press

= Vivid Color

= No Color Correction

= Monochrome

= Simulate Display

» Raw CMYK Colors

= Raw RGB Colors

= CMYK Sampler Chapter 6
= RGB Sampler

= HSB Sampler

= PANTONE Tek Phaser 540

= Fonts Sampler Chapter 7

= Reset Printer Chapter 9
= Setscreen Patch
= Tek Error Handler

= Format Printer Disk Appendix B
= No SysStart Job
= Set SysStart Job

= Configuration Page Appendix A
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Changing the printer's name

This procedure explains how to change the printer’s name. The printer’s
name has the following characteristics:

It prints on the startup and configuration pages.
It is used by both LocalTalk and EtherTalk to identify the printer.
It appears in the Chooser.

It can be up to 31 characters long, and may contain any printable
characters except @ (at sign) and : (colon).

The default printer name is Phaser 540. If more than one printer

has the same name in a given zone, numbers are appended to the
names of the printers added later; for example, Phaser 540-1 and

Phaser 540-2.

A name change is persistent across printer power cycles.

If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-12 to decompress this file.

Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility file in the folder on your hard disk
containing decompressed utility files.

Double-click on the LaserWriter Utility icon.

Select Name Printer from the Utilities menu. The currently
selected printer is listed in the dialog box.

Type the new name in the edit box.
Click the Rename button.
At the confirmation dialog box, click OK.

Open the Chooser to reselect the printer with its new name.
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Printing from an application

Note  For hints and tips on printing from a specific application, request
a document catalog from HAL or EuroHAL, the Tektronix
automated fax systems. Refer to page 9-2 for instructions on
using these systems.

The Phaser 540 Apps.sea archive file on the Macintosh Driver and Printer
Utilities diskette contains printer description files for the Phaser 540 printer.
Follow the instructions on page 2-12 to decompress these files.

These files are required by some applications; refer to your application’s
documentation to determine if you need to use one or more of these files.

You should always use the most current printer description file. To
determine the date of the file you are using, do the following:

1. Select (highlight) a file and choose Get Info from the File menu.
Make a note of the version date.

2. Check the Tektronix BBS to see if the PPD files you have are the
most recent. Refer to page 9-1 for instructions on using the BBS.
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A few applications and their corresponding printer description files are
listed in the following table. Refer to “Printer description files for Aldus,
Adobe, and other applications” on page 2-22 for details about each printer
description file.

Note  Most applications that use version 3.0 PPD files also use
PDX files.

Printer Description Files for the Phaser 540

Application and version number Printer Description File

Aldus PageMaker 4.0 or 4.01 Tek Phaser 540.APD*

Aldus PageMaker 4.2 TKPH5401.PPD (version 3.0)
(use both PPD and PDX) TKPH5401.PDX

Aldus PageMaker 4.2A TKPH5401.PPD (version 3.0)
(use both PPD and PDX) TKPH5401.PDX

Aldus PageMaker 5.0 TKPH5401.PPD (version 4.x)
Aldus FreeHand 2.0 Tek Phaser 540.APD*

Aldus FreeHand 3.0 or 3.1 TKPH5401.PPD (version 3.0)
(use both PPD and PDX) TKPH5401.PDX

Aldus FreeHand 4.0 TKPH5401.PPD (version 4.x)
QuarkXPress 3.11, 3.2, 3.3 Phaser 540.PDF

Canvas 3.0 TKPH5401.PPD (version 3.0)

* An APD file is not shipped with the printer. Check the Tektronix Bulletin Board Service (BBS)
for an APD file, or call Tektronix Customer Support; refer to page 9-1 for instructions.
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Printer description files for Aldus, Adobe, and other applications

There are 3.0 and 4.x versions of the PPD files; use the version required by
your application. Each version is located in a separate folder. However, if
you need to check the file’s version number (3.0 or 4.x), open the file in a text
editor and check the *FormatVersion line near the beginning of the file.

The PPD and PDX files are compressed into the Phaser 540 Apps.sea archive
file on the Macintosh Driver and Printer Utilities diskette. Follow the
instructions on page 2-12 to decompress these files, then continue with the
steps that follow for your version of the application. Most applications that
use version 3.0 PPD files also use PDX files.

Note  Also included on the Macintosh Driver and Printer Utilities
diskette are files for use with a Japanese Kanji language version of
the printer (TKP540J1.PPD, TKP540J1.PDX).

Aldus PageMaker 4.2 and 4.2A
Aldus FreeHand 3.0 and 3.1
Canvas 3.0

The TKPH5401.PDX and TKPH5401.PPD files in the 3.0 PPDs folder are
PostScript Printer Description files for use with Aldus, Adobe, and other
applications. Refer to your application’s documentation to see if this is the
PPD version you should use.

1. Locate the 3.0 PPDs Folder in the folder on your hard disk
containing decompressed files.

2. Place the 3.0 PPD file and the PDX file with your other PPD files
on your hard disk according to application needs.

Typically, PPD files are located in the PPDs folder, in the Aldus
folder, inside the System Folder. Refer to your application’s
documentation for details. This file is used automatically by
applications that require the information.

= If you are using Canvas 3.0, drag the 3.0 PPD and PDX files into
the PPDs folder on your computer’s hard disk. The PPDs folder
may be found in the Canvas folder if you don’t have any Aldus
applications.
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Aldus PageMaker 5.0 and Aldus FreeHand 4.0

The TKPH5401.PPD file in the 4.x PPDs folder is a PostScript Printer
Description file for use with Aldus, Adobe, and other applications. Refer to
your application’s documentation to see if this is the PPD version you
should use.

The 4.x PPD file is provided for support of future applications and may not
work with current applications that require the 3.0 PPD file. Refer to your
application’s documentation to see which version of the PPD file you should
use. Do not use this 4.x PPD file unless your application requires it.

1. Locate the 4.x PPDs Folder in the folder on your hard disk
containing decompressed files.

2. Place the 4.x PPD file with your other PPD files on your
computer’s hard disk according to application needs.

Typically, PPD files are located in the Printer Descriptions folder, in
the Extensions folder, inside the System Folder. Refer to the
application’s documentation for details.

= If you are using the LaserWriter 8.x printer driver, place the 4.x

PPD file in the Printer Descriptions folder, in the Extensions folder,
inside the System Folder.
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Printer description file for QuarkXPress

The Phaser 540.PDF file is a PostScript Printer Description file for
QuarkXPress 3.11, 3.2, and 3.3. QuarkXPress lets you install support for
other printers in addition to those shipped with the application. This file
adds the Phaser 540 printer to the QuarkXPress list of supported printers.

The Phaser 540.PDF file is compressed into the Phaser 540 Apps.sea archive file
on the Macintosh Driver and Printer Utilities diskette. Follow the
instructions on page 2-12 to decompress this file, then continue with the
steps listed below for your version of the application.

Note  For hints and tips on printing from QuarkXPress, request a
document catalog from HAL or EuroHAL, the Tektronix
automated fax systems. Refer to page 9-2 for instructions on
using these systems.

QuarkXPress 3.11 and 3.2

1. Locate the Phaser 540.PDF file in the folder on your hard disk
containing decompressed utility files.

2. Place the Phaser 540.PDF file in the same folder as the
QuarkXPress application on your computer’s hard disk.

3. The printer’s name appears alphabetically in the list of installed
printers in the QuarkXPress custom Page Setup dialog box.

QuarkXPress 3.3

1. Locate the Phaser 540.PDF file in the folder on your hard disk
containing decompressed utility files.

2. Place the Phaser 540.PDF file in the PDF folder inside the
QuarkXPress 3.3 application folder on your computer’s hard disk.

3.  The printer’s name appears alphabetically in the list of installed
printers in the QuarkXPress custom Page Setup dialog box.
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PANTONE Color template for Adobe lllustrator

Note

For the latest information on color libraries, call Tektronix
Customer Support in the U.S. and Canada at 1-800-835-6100.
Outside the U.S. and Canada, contact your local

Tektronix reseller.

The PANTONE-Tek Phaser 540.ai file lets you customize PANTONE Colors
for Adobe lllustrator and a Phaser 540 printer. This file is
application-specific and printer-specific.

The PANTONE-Tek Phaser 540.ai file is compressed into the Phaser 540
Apps.sea archive file on the Macintosh Driver and Printer Utilities diskette.
Follow the instructions on page 2-12 to decompress this file, then continue
with the steps listed below for your version of the application.

Adobe lllustrator 3.0

1.

Locate the PANTONE-Tek Phaser 540.ai file in the folder on your
hard disk containing decompressed utility files.

Drag the PANTONE-Tek Phaser 540.ai file to the Illustrator
application folder on your hard disk.

Use this file as a template to create documents for printing.

Adobe lllustrator 5.0

1.

Locate the PANTONE-Tek Phaser 540.ai file in the folder on your
hard disk containing decompressed utility files.

Drag the PANTONE-Tek Phaser 540.ai file to the Illustrator
application folder on your hard disk.

Choose Import Styles from the File menu and import the
PANTONE-Tek Phaser 540.ai file.
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PANTONE Color library files for Aldus applications

2-22

Note For the latest information on color libraries, call Tektronix
Customer Support in the U.S. and Canada at 1-800-835-6100.
Outside the U.S. and Canada, contact your local
Tektronix reseller.

The PANTONE-Tek Phaser 540.clib and PANTONE-Tek Phaser 540.acf files are
compressed into the Phaser 540 Apps.sea archive file on the Macintosh Driver
and Printer Utilities diskette. Follow the instructions on page 2-12 to
decompress these files, then continue with the steps listed below for your
version of the application.

FreeHand 3.0 and 3.1

The PANTONE-Tek Phaser 540.clib file is used by the application to properly
specify PANTONE Colors for Aldus FreeHand and a Phaser 540 printer.

= For FreeHand 3.0, refer to the Aldus FreeHand User Manual Version
3.0 for Apple Macintosh Computers for more information on color
libraries.

s For FreeHand 3.1, refer to the Aldus FreeHand Guide to Installation,
System 7.0 Compatibility, and Feature Updates: \Version 3.1 for Apple
Macintosh computers for more information on color libraries.

1. Locate the PANTONE-Tek Phaser 540.clib file in the folder on your
hard disk containing decompressed utility files. Place the file in a
convenient location.

2. Start FreeHand.

3. Open the Colors palette in FreeHand (or press Command + 9).
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4. Use one of the following methods to display the available color
libraries:

= FreeHand 3.0

Choose Library from the Colors palette submenu; a dialog box
appears listing the available color libraries.

= FreeHand 3.1

Choose Import from the Colors palette submenu; a dialog box
appears listing the available color libraries.

5. Select and open the PANTONE-Tek Phaser 540.clib color library file.
A dialog box appears with a list of available colors.

6. Select the color type, either Process or Spot.

7. Select the colors you want to use, then click OK. Use one of the
following methods to select colors:

= Select one color at a time.
= Hold down the Shift key and click to select several colors.
= Press Command + Ato select all the colors in the list.

Selected colors are added to the Colors palette, the Colors dialog
box, and all Colors pop-up menus.
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FreeHand 4.0

The PANTONE-Tek Phaser 540.acf file is used by the application to properly
specify PANTONE Colors for Aldus FreeHand and a Phaser 540 printer.

1. Locate the PANTONE-Tek Phaser 540.acf file in the folder on your
hard disk containing decompressed utility files. Place the file in a
convenient location.

2. Start FreeHand.
3. From the Colorlist window choose Options, Import, then select

PANTONE-Tek Phaser 540.acf.

PageMaker 5.0

The PANTONE-Tek Phaser 540.acf file is used by the application to properly
specify PANTONE Colors for Aldus PageMaker and a Phaser 540 printer.

1. Locate the PANTONE-Tek Phaser 540.acf file in the folder on your
hard disk containing decompressed utility files.

2. Place the PANTONE-Tek Phaser 540.acf file in the Color folder, in the
Aldus folder, inside the System Folder.

3. Start PageMaker.

4.  Choose Element, Define Colors, New, Libraries, then select
PANTONE-Tek Phaser 540.acf.
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Printing From a PC

Using the Tektronix printer driver for Windows

System requirements

The Tektronix Windows printer driver requires the following hardware
and software:

= An IBM or compatible computer, with a 386 or higher processor
= One floppy-disk drive (3.5-inch drive with 1.44-Mbyte capacity),
= Ahard disk

= Two Mbytes of memory

= MS-DOS 5.0 or higher operating system

= Windows 3.1
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Accessing on-line help

On-line help is available in two ways:

= For general Windows 3.1 information about printers and setting
options, select Help from the Control Panel menu bar and choose
a topic from the Help menu. A Help window appears, offering
information on the selected topic and listing other related topics.

= The Tektronix driver uses the Microsoft help file PSCRIPT.HLP.
This file is shipped with the Microsoft PostScript driver and must
be installed before you can use Help. After installing this file, you
can get information about the Tektronix driver by choosing Help
in the Printer Setup dialog box. (To access this dialog box, open
the Printers dialog; then open the Printers-Configure dialog.)

Do you already have Tektronix printers installed?

If you have any Tektronix printers that you installed using the older
Tektronix Installer program or you have the obsolete TekColor PS Previewer
software installed, you can remove the old files to clean up your hard disk.

After deleting the old files, you can use the latest Tektronix Windows driver
to reinstall all of your Tektronix printers using the current driver software.
For instructions on this procedure, request a document catalog from HAL or
EuroHAL, the Tektronix automated fax systems. Refer to page 9-2 for
instructions on using these systems.
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The Tektronix Windows driver is a Windows PostScript driver customized
for Tektronix printers. These instructions assume a basic familiarity with
Windows operation and terminology. For additional information about
Windows, refer to your Microsoft Windows documentation.

1.

6.

Start Windows.

Click the Add>> button.

Insert the Tektronix Windows 3.1 Driver and Printer Utilities
diskette into your computer’s disk drive; for example, drive B..

Open the Control Panel. Double-click on the Printers icon; the
Printers dialog box appears.

In the List of Printers, select Install Unlisted or Updated Printer.

=| Printers

Default Printer
[Tektmnix Phaser Il PXi on LPT1: ‘

[ Installed Printers:
HP Laserlet 4/4M PostScript on LPT1: +
Microsoft At Work Fax on FAX:

PostScript Printer on LPT1:

WINFAX on FaxModem hd

Set As Default Printer I

S| Usze Print Manager

List of Printers:

Generic / Text Only
Agfa 9000 Series P5

Agfa Compugraphic 400P5
Agfa Compugraphic Genics
Apple LazerwWTriter

Apple LaserwTriter [l NT
|Apple Laserwriter II NTX

Cancel

LConnect..

Bemove

Add »>

LR

Click the Install button.
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7. Type in the name of the drive containing the PC diskette (for
example, drive B:) and choose OK.

=| Install Driver

Insert unhsted. updated. or
vendor-provided printer driver digk in:

Cancel

|B:\ |

Browse._ ..

8. Select your printer and click OK.

=| Add Unlisted or Updated Printer
List of Printers:
Tek Phaser 300i [TekColor) +
Tek Phaser 440 [TekColor)

Tek Phazer 480 [TekColor
ek Phaser 540 [T ekl olo
Tek Phaser Il PX [TekColor]
Tek Phaser |l PXe [TekColor] 17 +

The driver software you need is automatically installed. Continue with the
next topic, “Configuring the driver.”
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Configuring the driver
1.

Printing From a PC

The Printers dialog box should already be displayed; if not, open
the Control Panel and double-click the Printers icon.

Select your printer from the list of installed printers.

Click the Set As Default Printer button if you want to select your
printer as the default.

Click the Connect button to display the Connect dialog box.

=| Connect
Tek Phaser 540 [TekColor)

Ports:

TOTI: . Local Dot mm—

LPT2: Local Port Hot Present
LPT3: Local Port Hot Prezent
COM1: Local Port

COM2:  Local Port Mot Present

" Timeouts [geconds] — ] Help
Device Not Selected:

Transmizzion Retiy:

Cancel

Settings. .

il

[1 Fast Printing Direct to Port
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5. Select the port that your printer is connected to.

Interface Select Then do the following
Parallel LPT1 or LPT2 Go to Step 6.
Serial COM1 or COM2 1. Click the Settings button to open

the Settings dialog box.

2. Fill in each item based on your
configuration, then click OK.

Refer to your Microsoft Windows
documentation for details, or ask
your network administrator for help.

Network Network port 1. Click the Network button to open
(LPT or COM) the Printers-Network
Connections dialog box.

2. Fill in each item based on your
configuration, then click OK.

Refer to your Microsoft Windows
documentation for details, or ask
your network administrator for help.

The printer’s configuration page contains the information you
need to set up the printer’s port. Refer to “Printing a
configuration page” on page A-4 for more information.

Note  You can use the FILE: port to send a PostScript document to a file
instead of to the printer. For more information, see your
Microsoft Windows documentation.
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Set the Timeouts. These options regulate your computer’s
communications with its printer ports.

= Device Not Selected
Type a value of 0, or between 15 and 999, in this text box to change
the number of seconds Windows waits before notifying you that a
printer is off-line. The default is 15 seconds.

= Transmission Retry
On large or multiple-page documents, you may see an alert
message that the printer is no longer accepting data before the job is
completely downloaded to the printer. When using the Print
Manager with a shared printer, set this option to a larger value,
such as 850, to avoid these unnecessary timeouts. Type a value
between 45 and 850 in this text box; the default value is 45 seconds.

Click OK to return to the Printers dialog box, then click the Setup
button. A dialog box appears with the name of the printer you
selected across the top. Use this dialog box to select the paper
source, paper size, and image orientation.

Click the Options button to open the Options dialog box. Make
sure that the Color box is checked to print in color.

From the Options dialog box, click the Advanced button to open
the Advanced Options dialog box. Make sure the Use PostScript
Level 2 Features check box is checked.

The Use PostScript Level 2 Features option affects the print
time of bitmapped (raster) images by improving the image
transfer time from the computer to the printer, and by improving
the image processing time in the printer. This option is available
only to applications that use this Tektronix driver with Tektronix
PostScript Level 2 printers, such as the Phaser 540. When this
box is checked, the Compress Bitmaps option is unavailable
(grayed out).
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3-8

10.

11.

12.

13.

Click OK to return to the Options dialog box.

In the Options dialog box, click the Printer Features button to
open the Tektronix Printer Features dialog box. Make color
correction and print quality selections as desired. Click OK to
return to the Options dialog box.

Click OK to return to the dialog box that lists your printer’s name
across the top.

Click OK to return to the Printers dialog box; then choose the
Close button.

If you are using PC/NFS

If you have PC/NFS software installed on your computer, you need to make
the following selection in the Network Options dialog box:

1.

2.

Double-click the Print Manager icon in the Main window.

Select Network Settings from the Options menu in the Print
Manager.

Uncheck the Print Net Jobs Direct box in the Network Options
dialog box.

Click OK.
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Using the driver’s options

Use the following dialog boxes to select printing options:

= Printer Setup dialog box
= Options dialog box
= Tektronix Printer Features dialog box

Making selections in the Printer Setup dialog box

To reach the Printer Setup dialog box without running an application, open
the Control Panel, double-click on the Printers icon, then click the Setup
button. Make printer selections in the fields described in the following table.

=-| Tek Phaser 540 [TekColor] on LPT1:
Paper Source: |Papet |£I I LIS I
Paper Size: |Letter 85x11in |£I | Cancel I

Orientation

Copies:
- Portrait EI

{_ Landscape

Printer Setup dialog box options

Dialog box options Option description

Paper Source

Select a paper source from the pop-up menu. Refer to the table on page 5-7 for a complete
list of paper sources.

Paper Size Select a paper size from the pop-up menu. Refer to the table on page 5-2 for a list of paper
sizes and image areas.

Orientation Select one of the following options to determine how an image is placed on the paper:
= Portrait (vertical)
= Landscape (horizontal)

Copies Type in the number of copies (prints) you want. (You may want to set the number of copies

from your application because the number of copies in the Printer Setup dialog box remains
the same until you change it again.)

If you are printing multiple copies, make sure the Transmission Retry (described on page
3-9) is set for at least 600 seconds (10 minutes).
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Making selections in the Options dialog box

From the Printer Setup dialog box, click the Options button to open the
Options dialog box. Refer to your Microsoft Windows documentation for
details on the options in this dialog box. Make printer selections in the fields
described in the following table.

=| Options
Print To OE
& Printer
2} Encapsulated PostScript File Cancel I
Hame: | |
Marging — |
@ ls)le[aull Scaling [%)] Send Header...
Ot _ | Wt
< Send Header with Each Job

Options dialog box options

Dialog box options

Option descriptions

Print To

Select one of the following options:
= Printer

= Encapsulated PostScript File  (This option generates an EPS graphic that can be
imported into other applications. This option does not create a printable file. Use the
FILE port to print to a file.)

Scaling Type in a percentage value to scale the printed image.
Margins Select one of the following options:
= Default
= None
Color Check this box on to print in color.
Send Header with This box must be checked on.
Each Job (The header contains important PostScript information that must accompany each print

job; it is not a banner page printed with each job. If this box is not checked, an error
message is displayed on your computer screen and your job does not print.)

Printer Features button

Choose this button to open the Tektronix Printer Features dialog box.
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Making selections in the Tektronix Printer Features dialog box

From the Options dialog box, click the Printer Features button to open the
Tektronix Printer Features dialog box. Make printer selections in the fields
described in the following table. Refer to Chapter 5, “Selecting Media and
Image Options,” and Chapter 6, “Using Color,” for details on these options.

Tektronix Printer Features

Color Correction: |Vivid Color |£| 1] 4 I
Print Quality: |Standard |£I Cancel I

<] Dutput Face Up?

Tektronix Printer Features dialog box options

Dialog box options Option description

Color Correction Select one of the following options:
= None
= Vivid Color

= Simulate Display
= SWOP Press

= Euroscale Press
= Commercial Press
= Monochrome

» Use Printer Setting

Print Quality Select one of the following options (see page 5-10
for more information on these options):
= Fast
= Standard
= Enhanced

Output Face Up To stack printouts face up, check this box.

To stack printouts face down, uncheck this box.
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Installing the Tektronix driver on a network

Note  For more information on the following procedure, request a
document catalog from HAL or EuroHAL, the Tektronix
automated fax systems.

1. Install the Tektronix Windows driver as described on page 3-4.

2. Editthe CONTROL.INF file as follows to make the driver available
to other users:

a. Start Notepad, or a similar text editor.

b. Insert the Tektronix Windows 3.1 Driver and Printer Utilities
diskette into your computer’s disk drive; for example, drive B.

c. In Notepad, open the CONTROL.ADD file on the Tektronix
diskette.

d. Locate the Tektronix Phaser printer entries. Select your printer
(highlight the line for your printer), and copy the line to the
Clipboard by selecting Copy from the Edit menu. If desired,
you can select and copy all the Tektronix printers listed.
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e. In Notepad, open the CONTROL.INF file located in the
network WINDOWS\ SYSTEM subdirectory by selecting
Open from the File menu.

f.  Search for the string Phaser to find the existing Tektronix
printer entries.

g. Select Paste from the Edit menu to paste the printer
information from the Clipboard into the CONTROL.INF file
above the existing Tektronix printer entries.

h. If desired, the existing Tektronix printer entries can be deleted
or commented-out by placing a semicolon (;) at the beginning
of each line. It might be less confusing to users to have only
one Tektronix printer to choose from in the driver.

Windows users can add the Tektronix printer to their Printers
Control Panel using the Add>> button.

Printing Reference
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Updating the standard Microsoft Windows
PostScript driver

If you prefer to use the standard Microsoft Windows PostScript printer
driver instead of the Tektronix Windows driver, follow these instructions.
This update procedure provides printer page size information for Windows
applications using the standard Microsoft driver. However, color corrections
and other PostScript Level 2 features are available only with the Tektronix
Windows 3.1 driver and are not supported by the standard Microsoft driver.
Refer to Chapter 6, “Using Color,” for instructions on other ways of selecting
color corrections.

These instructions assume a basic familiarity with Windows operation and
terminology. For additional information about Windows, refer to your
Microsoft Windows documentation.

Note If you want to install the Tektronix Windows driver, follow the
instructions on page 3-4.

1. Start Windows.
2. Open the Control Panel.
3. Double-click on the Printers icon.

4. Click the Add>> button; a list of printers displays.
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o

Select Install Unlisted or Updated Printer.
6. Click the Install button.

7. When prompted, insert the Tektronix Windows 3.1 Driver and
Printer Utilities diskette into your computer’s disk drive.

8. Type in the letter for the computer’s disk drive followed by the
\WPD subdirectory:

B:\WPD
Then click OK.

9. Select your printer from the list, then click OK.

Note  Printers using the Tektronix Windows driver have (TekColor)
listed in their name. Printers without this designation are using
the standard Microsoft Windows PostScript driver and the
WPD file.

10.  When asked to insert a diskette containing the updated
PSCRIPT.DRV file, enter the path for your WINDOWS\SYSTEM
subdirectory, or insert the appropriate Microsoft Windows
diskette. This ensures that the current PSCRIPT.DRYV file is used.
(The PSCRIPT.DRYV file is not included on the Tektronix diskettes.)
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Updating a Windows NT PostScript driver

If you are using Microsoft Windows NT, follow these instructions to print to
a Phaser 540. This update procedure provides printer page size information
for Windows NT applications. However, TekColor color corrections and
other PostScript Level 2 features are not supported by the Windows NT
driver. Refer to Chapter 6, “Using Color,” for instructions on other ways of
selecting color corrections. Refer to your Microsoft Windows NT
documentation for details on features in the Windows NT driver.

These instructions assume a basic familiarity with Windows NT operation
and terminology. For additional information about Windows NT, refer to
your Microsoft Windows NT documentation.

Note  You may need your original Windows NT setup diskettes (or
CD-ROM) to complete this procedure if you need to install a
PostScript printer in Step 4.

1. Start your system with Windows NT.

2. If your computer platform has an Intel-compatible processor, such
as the Intel 1386, go on to Step 3.

If your computer platform is a MIPS or Alpha, you need to edit the
PRINTER.INF file in the APPLSPEC\PPD4.x directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

a. The Tektronix Windows 3.1 Driver and Printer Utilities
diskette is write-protected. To edit the PRINTER.INF file, copy
the following files from the Tektronix diskette to a new,
formatted floppy diskette. Place all three files at the top (root)
level of the new diskette.

TEK1 (from the top level of the Tektronix diskette)
PRINTER.INF (from the APPLSPEC\PPD4.x subdirectory)
TKPH5401.PPD (from the APPLSPEC\PPDA4.x subdirectory)

b. Open the copy of the PRINTER.INF file on the new diskette in
a text editor such as Notepad.
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c. Locate the following section in the file:

[ProductType]
STF_PLATFORM = 1386

d. Replace the 1386 with either MIPS (for a MIPS platform) or
Alpha_AXP (for an Alpha platform).

e. Save the PRINTER.INF file and go to Step 3.
From the Main window, double-click on the Print Manager icon.
If you have a PostScript printer driver installed, go to Step 5.

If you don’t have a PostScript printer driver installed, install one
now. You need to have a PostScript printer driver installed
because these driver files are needed later in this procedure to
complete the Tektronix Phaser 540 driver installation.

a. From the Printer menu, select Create Printer; the Create
Printer dialog box appears.

b. Under Driver, scroll through the list and select a PostScript
printer, such as the Apple LaserWriter, and choose the
OK button.

c. Follow the on-line instructions to install the driver files from
your Windows NT CD-ROM or diskettes.

Install the Tektronix Phaser 540 printer driver. From the Printer
menu, select Create Printer; the Create Printer dialog box
appears.

Under Driver, scroll to the end of the list and select Other; the
Install Driver dialog box appears.

When prompted, insert either the Tektronix Windows 3.1 Driver
and Printer Utilities diskette, or the new diskette you created in
Step 2, into your computer’s disk drive.
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10.

11.

12.

13.

Note

If you are using the Tektronix Windows 3.1 Driver and Printer
Utilities diskette: Type in the disk drive location of the diskette

and change to the APPLSPEC\PPD4.x directory. Click OK; the
Select Driver dialog box appears.

= Ifyou are using an edited copy of the PRINTER.INF file from
Step 2: Type in the disk drive location of the diskette. Click OK;
the Select Driver dialog box appears.

Under Printer Driver, choose the Phaser 540 printer from the list,
then click OK.

In the Windows NT Setup dialog box, type in the same path you
used in Step 7 (for example, B:NAPPLSPEC\PPD4.x).

Click the Continue button; the Noncritical Error dialog box
appears.

When you are prompted for the location of the PSCRPTUI.DLL file
and the PSCRIPT.DLL file, click the Ignore button. (These files
were installed previously.)

When the Create Printer dialog box appears, fill in the other fields
as desired, then click OK; the PostScript Printer Setup dialog box
appears.

Select options in the PostScript Printer Setup dialog box.
Enabling the Use Printer Halftoning option is recommended.
Then click OK; the Windows NT Setup dialog box appears.

If you installed a PostScript printer driver in Step 4, follow this
procedure to delete it. (Now that the Phaser 540 driver is installed,
this driver is not needed.)

a. Select the printer you want to remove.

b. From the Printer menu, select Remove Printer.

c. Atthe prompt, click OK to remove the selected printer.

Use the following page sizes with the Phaser 540: Letter and A4.
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Printing from DOS

Note  Driver-selectable TekColor color correction features are available
only through the Tektronix drivers for the Windows environment
and Macintosh computers as described in this manual. Refer to
Chapter 6, “Using Color,” for instructions on other ways of
selecting color corrections.

Printing from a driver

Many DOS applications include printer drivers for Tektronix printers.
Check your application to see if it was shipped with a printer driver for a
Phaser 540. Install and use the driver according to the application’s
documentation.

If the application you are using does not have a driver for a Phaser 540:

= Check to see if other Tektronix Phaser series printers are listed,
and choose one of them. Otherwise, you can use a generic color
PostScript printer driver. However, generic drivers do not have
information on the printer’s page sizes and image areas, so images
may be clipped or shifted when printed.

= Contact the application’s vendor, or call Tektronix Customer
Support in the U.S. and Canada at 1-800-835-6100, for
printing information. Outside the U.S. and Canada, contact your
local Tektronix reseller.

Refer to the Phaser 540 Color Printer User Manual for information on using the
DOS MODE command to disable timeouts on a parallel port.

Using color corrections

DOS drivers do not include the TekColor color correction options. Refer to
Chapter 6, “Using Color,” for instructions on other ways of selecting color
corrections.
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Using the PC utility files

The utility files change the way the printer operates. To use the files, send
them to the printer from the communications port your printer is
connected to. You can use either the DOS method or the Windows method
described in the following topics.

Downloading files from DOS

You can use the DOS COPY command to download PostScript files to
the printer.

1.

Locate the files you want to use on the Tektronix Windows 3.1
Driver and Printer Utilities diskette. You can copy the files to
your computer's hard disk, or use the files directly from the
diskette.

Use the DOS COPY command to send the desired file to the
printer. For example, to reset the printer, you would send the
RESET.PS file to the printer.

If your printer is connected to the parallel (LPT) port, type the
following command (where x is 1, 2, or 3):

COPY RESET.PS LP:

If your printer is connected to the optional serial (COM) port, type
the following command (where x is 1, 2, or 3):

COPY RESET.PS COMx:
If your printer is connected to an optional Novell or TCP/IP

network, you should follow the instructions provided with your
network software.
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Downloading files from Windows

You can use the Copy command in the Windows File Manager to download
PostScript files to the printer.

1.

Locate the files you want to use on the Tektronix Windows 3.1
Driver and Printer Utilities diskette. You can copy the files to
your computer's hard disk, or use the files directly from the
diskette.

In Windows, double-click the File Manager icon in the Main
window.

Locate the drive and directory or subdirectory containing the
printer’s utility files.

Select the utility file you want to send to the printer, for example
RESET.PS.

Select Copy from the File menu. The Copy dialog box appears
with the selected utility file displayed in the From field.

-| Loy
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In the To field, type the port your printer is connected to. For
example, type LPT1: for a parallel port connection.
Click OK.

If the Confirm File Replace dialog box appears, click the Yes
button to continue. The file is downloaded to the printer.
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All of the files in the following table can be downloaded to the printer using

the DOS COPY command or the Windows File Manager.

Downloadable utility files

Where to find details

» ADDCTRLD.BAT CTRLD.PS Chapter 3
= DEVPARAM.PS Chapter 3
= PRNTNAME.PS Chapter 3
= ANYTRAY.PS MIDDTRAY.PS Chapter 5
= LOWRTRAY.PS UPPRTRAY.PS

= COMRCIAL.PS RAWCMYK.PS Chapter 6
= DISPLAY.PS RAWRGB.PS

= EUROSCAL.PS SWOPRESS.PS

= MONOCHRM.PS VIVDCOLR.PS

= NOCORECT.PS

= FONTS.PS Chapter 7
= RESETPS TEKEHAND.PS Chapter 8
» SETSCRN.PS

= FRMTDISK.PS NOSYSTRT.PS Appendix B
= INITDISK.PS SYSTART.PS

= AIS.PS HPGLTEST.PLT Appendix C
» HPGL.PS PSTEST.PS

= HPGLPENS.PS PSCRIPT.PS

= CONFIG.PS Appendix C
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Changing the printer's name

This procedure explains how to change the printer’s name. The printer’s
name has the following characteristics:

= It prints on the startup and configuration pages.
= Itis used by both LocalTalk and EtherTalk to identify the printer.

= It can be up to 31 characters long, and may contain any printable
characters except @ (at sign) and : (colon).

=  The default printer name is Phaser 540. If more than one printer
has the same name in a given zone, numbers are appended to the
names of the printers added later; for example, Phaser 540-1 and
Phaser 540-2.

= Aname change is persistent across printer power cycles.

1. Locate the PRNTNAME.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

2. Copy the file to your hard disk for editing.

3. Open the PRNTNAME.PS file in a text editor.
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Note

Substitute a different printer name for (My Printer Name) in the
/PrinterName line and save the file.

Use one of the following methods to send the file to the printer:

PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See
page 3-26 and page 3-28 for details.

Workstation users: Send the file to the printer as you would any
PostScript file.

Some text editors add a carriage return or line feed after the last
Control-D character in files you edit. If your computer is
connected to the printer through the parallel port, or the optional
serial port, the extra characters start a new job and the printer
times out after a few minutes. To avoid this, copy the CTRLD.PS
file to the printer after you send the PRNTNAME.PS file; see
page 3-34 for more information on the CTRLD.PS file.
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Adding Control-D characters to PC files

The ADDCTRLD.BAT and CTRLD.PS files are located in the PHSR540
directory on the Tektronix Windows 3.1 Driver and Printer Utilities diskette.
These files are included for users who want to write their own

PostScript files.

Note  If your computer is connected to the printer through the parallel
port, or the optional serial port, you need to use Control-D
characters in your utility files or in the files you create. However,
if your computer is connected to a network such as NetWare or
TCP/IP, you should not add Control-D characters to a utility file.

The non-text Control-D character is required at the end of PostScript files
sent to the printer’s parallel port, or the optional serial port; it signals
“end-of-job.” A Control-D should precede and follow most PostScript data
files. ADDCTRLD.BAT and CTRLD.PS help you add two Control-D
characters to your files.

ADDCTRLD.BAT

ADDCTRLD.BAT is a batch file that adds a Control-D to the beginning and
the end of a file. Use this file if you are creating your own PostScript files.

To use ADDCTRLD.BAT, copy ADDCTRL.BAT and CTRLD.PS to the same
directory on your hard disk. Type the following command:

ADDCTRLD filename

where filename is the name of the file that needs Control-D characters.

CTRLD.PS

CTRLD.PS contains some PostScript comments plus the Control-D character.
Copy CTRLD.PS to the beginning and/or end of your PostScript files before
you send them to the printer. (PostScript utility files on the Tektronix
Windows 3.1 Driver and Printer Utilities diskette already have Control-D
characters at the beginning and end.) You can send CTRLD.PS to the printer
by itself to make sure the printer is in the “end of job” state.
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Printing from an application

Note  For hints and tips on printing from a specific application, request
a document catalog from HAL or EuroHAL, the Tektronix
automated fax systems. Refer to page 9-2 for instructions on
using these systems.

Printer description files are located in the APPLSPEC directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette. These files are
required by some applications; refer to your application’s documentation to
determine if you need to use one or more of these files.

You should always use the most current printer description file. To
determine the date of the file you are using, do the following:

1. Select (highlight) a file and choose Get Info from the File menu.
Make a note of the version date.

2. Check the Tektronix BBS to see if the PPD files you have are the
most recent. Refer to page 9-1 for instructions on using the BBS.

A few applications and their corresponding printer description files are
listed in the table below; see the pages that follow for details on each printer
description file.

Printer Description Files for the Phaser 540

Application and version number Printer Description File

Aldus PageMaker 4.0, 4.2, 4.2A TKPH5401.PPD (version 3.0)
(use both PPD and PDX) TKPH5401.PDX

Aldus PageMaker 5.0 TKPH5401.PPD (version 4.x)
Aldus FreeHand 3.0 or 3.1 TKPH5401.PPD (version 3.0)
(use both PPD and PDX) TKPH5401.PDX

Aldus FreeHand 4.0 TKPH5401.PPD (version 4.x)
QuarkXPress 3.3 TKPH5401.PDF

(requires Windows 3.1)
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Printer description files for Aldus, Adobe, and other applications

There are 3.0 and 4.x versions of the PPD files; use the version required by
your application. Most applications that use 3.0 PPD files also use PDX files.

Note  Also included on the Windows 3.1 Driver and Printer Utilities
diskette are files for use with a Japanese Kanji language version of
the printer (TKP540J1.PPD, TKP540J1.PDX).

Aldus PageMaker 4.0, 4.2 and 4.2A
Aldus FreeHand 3.0 and 3.1

The APPLSPEC\PPD3.0 subdirectory on the Tektronix Windows 3.1 Driver
and Printer Utilities diskette contains the version 3.0 TKPH5401.PPD file and
the TKPH5401.PDX file that are required by some Windows applications,
such as Aldus FreeHand and PageMaker.

To use these files, copy them to the directory on your computer’s hard disk
where your other PPD files are located. For example, the subdirectory
which contains printer description files for FreeHand should be called
ALDUS\USENGLSH\PPDS. Refer to your application’s documentation for
details on using printer description files.

Aldus PageMaker 5.0 and Aldus FreeHand 4.0

The APPLSPEC/PPD4.x subdirectory on the Tektronix Windows 3.1 Driver
and Printer Utilities diskette contains the version 4.x TKPH5401.PPD printer
description file. This file is provided for support of certain Windows
applications, such as newer Aldus applications.

To use this file, copy it to the directory on your hard disk where your other
PPD files are located. For example, the subdirectory which contains printer
description files for FreeHand should be called ALDUS\USENGLSH\PPD4.
Refer to your application’s documentation for details on using printer
description files.
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Printer description file for QuarkXPress

The TKPH5401.PDF file is a PostScript Printer Description file used with
QuarkXPress 3.3 and Windows 3.1. To install the file, copy TKPH5401.PDF
from the Tektronix Windows 3.1 Driver and Printer Utilities diskette into the
PDF subdirectory of the QuarkXPress 3.3 application. For example:

COPY TKPH5401.PDF C:\XPRESS33\PDF
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PANTONE Color library file for Adobe Illustrator

Note For the latest information on color libraries, call Tektronix
Customer Support in the U.S. and Canada at 1-800-835-6100.
Outside the U.S. and Canada, contact your local
Tektronix reseller.

The TEK _540.Al file is located in the APPLSPEC directory on the Tektronix
Windows 3.1 Driver and Printer Utilities diskette. This file lets you
customize PANTONE Colors for Adobe Illustrator and a Phaser 540 printer.
This file is application-specific and printer-specific.

Adobe lllustrator 3.0 and 4.02

1. Copy the TEK_540.Al file to your computer’s hard disk; for
example, to Adobe Illustrator’s Color directory.

2. Start the Illustrator program.
3. Open the file or image you want to use.
4. From the File menu, select the Open command.

5. In the dialog box that appears, locate the directory and file
location of the TEK_540.Al file, and open the file.

6.  When you are working on an image, use the Paint menu and

either the Paint Style or Custom Color commands to select
PANTONE Colors.
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PANTONE Color library file for Aldus applications

Note For the latest information on color libraries, call Tektronix
Customer Support in the U.S. and Canada at 1-800-835-6100.
Outside the U.S. and Canada, contact your local
Tektronix reseller.

FreeHand 3.0 and 3.1

The TEK_540.CLB file is located in the APPLSPEC directory on the Tektronix
Windows 3.1 Driver and Printer Utilities diskette. This file is used by the
Aldus FreeHand application to properly specify PANTONE Colors for the
Phaser 540 printer. This file is application-specific and printer-specific.

1. Copy the TEK 540.CLB file to your computer’s hard disk; for
example, to the FreeHand application directory.

2. Open FreeHand.

3. Use one of the following methods to display the available color
libraries:

= FreeHand 3.0
Choose Library from the Colors palette submenu; a dialog box
appears listing available color libraries.

= FreeHand 3.1
Choose Import from the Colors palette submenu; a dialog box
appears listing available color libraries.

4. Select and open the TEK_540.CLB color library; a dialog box
appears with a list of available colors.

5. Select the colors you want to use, then click OK. Selected colors

are added to the Colors palette, the Colors dialog box, and all
Colors menus.
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PageMaker 5.0

The TEK_540.ACF file is located in the APPLSPEC directory on the Tektronix
Windows 3.1 Driver and Printer Utilities diskette. This file is used by the
application to properly specify PANTONE Colors for Aldus PageMaker and
a Phaser 540 printer. This file is application-specific and printer-specific.

1. Copy the TEK_540.ACF file from the Tektronix Windows 3.1
Driver and Printer Utilities diskette to your hard disk.

2. Place the file in the USENGLSH\COLORN\ subdirectory in the
ALDUS application directory.

3. Start PageMaker.

4. Choose Element, Define Colors, New, Libraries, then select the
Phaser 540.
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PANTONE Color palette file for CoreIDRAW!

Note For the latest information on color libraries, call Tektronix
Customer Support in the U.S. and Canada at 1-800-835-6100.
Outside the U.S. and Canada, contact your local
Tektronix reseller.

The TEK _540.PAL file is located in the APPLSPEC directory on the Tektronix
Windows 3.1 Driver and Printer Utilities diskette. This file is used by the
CorelDRAW! application to properly specify PANTONE Colors for a
Phaser 540 printer. This file is application-specific and printer-specific.

1. Copy the TEK_540.PAL file to your computer’s hard disk; for
example, to the Corel application directory.

2. Open CorelDRAW!.
3. Open the document file you want to work in.

4. Select the item you want filled with a PANTONE Color, then select
the Fill tool icon (paint bucket).

5. Select the Fill tool icon again, then click the Open button
under Palette.

6. Inthe dialog box under Path, specify the location of the
TEK_540.PAL file.

7. Under Files, select the TEK_540.PAL file and click the Load button.
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Chapter

Printing from a UNIX
Workstation

Printing information

You can send print files from your workstation to a Phaser 540 printer as you
would to any PostScript printer; for example, the Apple LaserWriter.
Workstation users can print from any application that generates PostScript
Level 1 or Level 2.

For more information on printing from a workstation, request a document
catalog from HAL or EuroHAL, the Tektronix automated fax systems. Refer
to page 9-2 for instructions on using these systems.

You can access the TekColor color corrections and other printer features
using the downloadable utility files described in this manual, or the printer’s
front panel menus. Refer to the Phaser 540 Color Printer User Manual for
instructions on using the printer’s front panel.
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Faster printing with Tektronix Phaser Print software

42

For Unix and VMS environments, Tektronix offers Phaser Print. Phaser Print
provides fast raster screen copy printing to Tektronix color printers. Phaser
Print also provides a graphical user interface for push-button control of
Tektronix printer features.

Phaser Print software is available for these workstations:

Sun: SunOSs 4.1.X, Solaris 2.X
SGI: IRIX 4.0.5and 5.2

HP 9000 700/800: HPUX 9.X

IBM RS/6000: AlX 3.2

DECstation: Ultrix 4.X

DEC Alpha AXP: OSF/11.3

DEC VAX*: VMS

DEC Alpha AXP*: Open/VMS

*Supported through alternate printing solutions

Phaser Print works with the workstation’s native spooling system to print
PostScript files and raster files in these formats: Sun Raster Format (SRF),
xwd, and SGI RGB.

If you ordered the TCP/IP Ethernet option for your printer, you received a
demonstration copy of Phaser Print on a compact disk (CD). If you did not
receive a demonstration CD but would like one, contact your dealer, local
Tektronix office or in the United States or Canada call 1-800-835-6100.

For information on printing from workstations and setting up spooling
systems, you can contact HAL, the Tektronix automated fax system by
calling direct (503) 682-7450 or, in the United States or Canada, by calling
toll-free 1-800-835-6100. Refer to page 9-2 for details on using the HAL
system.
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Locating workstation procedures

The following table lists procedures and tasks for workstation users that are

described in other chapters in this manual:

Task Where to find details
Changing the printer's name. page 3-23

Selecting media trays. page 5-7

Selecting print quality. page 5-11

Selecting color corrections. page 6-7

Printing color sampler charts.

page 6-15 and page 6-17

Printing a font sampler. page 7-6
Using the Tektronix error handler. page 9-9
Using the Setscreen patch for halftone screens. page 9-17
Resetting the printer. page 9-23
Enabling and disabling the startup page. page A-2
Printing a configuration page. page A-4
Setting the EtherTalk Zone. page A-6
Enabling and disabling front panel menus. page A-9
Configuring a serial port. page A-11
Formatting a SCSI hard disk. page B-2
Initializing a formatted SCSI hard disk. page B-4
Controlling SysStart Job files. page B-5
Setting PostScript job and wait timeouts. page C-2
Changing printer language mode. page C-4
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Using the utility files

For some printer features, you can use the downloadable utility files
available on the Tektronix Windows 3.1 Driver and Printer Utilities diskette.
To mount the diskette, refer to the instructions on page 4-6. If you cannot
use this diskette, refer to page 4-8 for instructions on obtaining the files from
other sources.

You can use the utility files to perform a variety of tasks, such as changing
the printer’s name, resetting the printer, and using an error handler. The
utility files are written in the PostScript Level 2 programming language. Ina
few cases, you may have to edit the utility files to change the default
parameters.

About Control-D characters

4-4

A Control-D character is used to indicate the end of a file when printing
through a parallel or a serial port. Without a Control-D character in the file,
the printer continues waiting for more input.

All PostScript utility files, except RESET.PS, should start and end with a
Control-D character when sent from a workstation over a parallel or serial
interface. In the file descriptions, Control-D is denoted as CTRL-D. For
more information about PostScript programming, refer to the PostScript
Language Reference Manual, second edition, Adobe Systems Incorporated.
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Removing Control-D characters from utility files

1.

Locate the delctrld UNIX shell script in the PHSR540 directory on
the Tektronix Windows 3.1 Driver and Printer Utilities diskette.
You must copy this file to your workstation before you can use it.
(Or, obtain this shell script using one of the methods described in
“Obtaining the PC utility files” on page 4-8.)

To remove all Control-D characters from a file, type the following
command:

delctrld  filenamel.ps filename2.ps

where filenamel.ps is the utility file you want to remove Control-D
characters from, and filename2.ps is the revised file with a new
name. (Both filenamel.ps and filename2.ps can have the same name,
but the original file will be overwritten by the revision.)

Send the utility file to the printer as you would any PostScript file.

Adding Control-D characters to utility files

1.

Locate the addctrld UNIX shell script in the PHSR540 directory on
the Tektronix Windows 3.1 Driver and Printer Utilities diskette.
You must copy this file to your workstation before you can use it.
(Or, obtain this shell script using one of the methods described in
“Obtaining the PC utility files” on page 4-8.)

To add Control-D characters to the beginning and end of a file,
type the following command:

addctrld  filenamel.ps filename2.ps
where filenamel.ps is the utility file you want to add Control-D
characters to, and filename2.ps is the revised file with a new name.
(Both filenamel.ps and filename2.ps can have the same name, but the
original file will be overwritten by the revision.)

Send the utility file to the printer as you would any PostScript file.
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Mounting the PC/DOS diskette on a workstation

Note  The following procedures give instructions for mounting the
PC/DOS diskette on SGI IRIX versions 4.0.x and 5, and Sun
running Solaris 2.3. For instructions on mounting the diskette
on a Sun OS 4.1.3, request document number 9501 from HAL,
the automated fax system. Refer to page 9-2 for instructions.

SGI IRIX versions 4.0.x and 5

46

PC/DOS-formatted diskettes can be easily mounted in the SGI environment.
For more information, print the appropriate man pages on your system.

IRIX version 4.0.x uses the msdosd daemon to mount a floppy diskette.

IRIX version 5 uses the mediad daemon to mount all types of devices,
including floppy diskettes. Both operating system versions have the utilities
from_dos and to_unix to convert files and add or remove Control-M
characters.

To mount a diskette, insert the diskette into the disk drive.

msdosd

The msdosd daemon monitors a floppy disk drive. When a diskette is
inserted, it is mounted automatically if it is in MS-DOS format. To specify a
floppy disk drive, use the appropriate device special file in /dev/rdsk
High-density diskettes are mounted by using floppy devices with the

hi suffix.

mediad

The mediad daemon monitors the removable media devices on a system.
When a diskette is inserted, it is mounted if it makes sense for that media
type and if there is a valid filesystem on it.

Phaser 540 Drivers and Utilities



Printing from a UNIX Workstation 4

Sun running Solaris 2.3

PC/DOS-formatted diskettes can be mounted in two ways in the Solaris
environment, either automatically or manually. For more information, print
the appropriate man pages on your system.

Automatic diskette mounting instructions

If the volume manager is running, the PC/DOS diskette will be mounted
automatically when the diskette is inserted in the disk drive.

To see if the volume manager is running, type the following command:

ps -ef | grep vold
To see a list of the diskette’s contents, do the following:

Run OpenWindows.
Open the File Manager.
Insert the PC/DOS diskette.

Click the File button in the File Manager window, then click
Check for Floppy.

L e

The File Manager displays the files on the diskette. You can then
copy the files to your hard disk, or send the files to the printer
using the Ip print command.

Manual diskette mounting instructions

If the volume manager is not running, you can manually mount the
PC/DOS diskette. Type the following command:

mount -F pcfs  device-special directory-name

Or, if the device name (/dev/diskette - /pcfs pcfs -no- ) is in your
(fetcivistab ) directory, type the following command to mount the diskette:

mount /pcfs

You can then copy the files to your hard disk, or send the files to the printer.
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Obtaining the PC utility files

There are two ways to obtain the utility files if you cannot mount the
PC/DOS diskette:

= Refer to page 9-6 for instructions on using the Internet to
download Tektronix files.

= Refer to page 9-1 for instructions on using the Tektronix Bulletin
Board Service (BBS).
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Chapter

Selecting Media and
Image Options

This chapter explains how to do the following tasks:

Selecting media sizes
Selecting media trays
Printing manual feed
Selecting print quality
Selecting image orientation

Choosing the output (stack) order
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Selecting media sizes

5-2

The Paper (Macintosh) or Paper Size (Windows) options in the Tektronix
drivers let you choose the media size to print on. The drivers support both
US and metric media sizes. The default is Letter (8.5 x 11 inches). Refer to
the Phaser 540 Color Printer User Manual for more information on loading
media trays.

Phaser 540 special media sizes

Media sizes Dimensions Image area
Letter 8.5x 11 ins. 8.1 x10.6 ins.
A4 210 x 297 mm 200 x 288 mm

Phaser 540 Macintosh driver (based on LaserWriter 7.1.2)

The Paper options are located in the Page Setup dialog box. The first four
selections are the standard LaserWriter paper sizes (US Letter, US Legal, A4
Letter, and B5 Letter). The fifth Paper option field is a pop-up menu with
special Tektronix media sizes.

Phaser T80 112 E

Paper: O Letter ()84 Lettei

Cws Leged D185 Loner @ |wletier | || Canced |

A4
Redice o Frimi |:: |
=
B g El [5] Faai dubslitetieat
Orientation (] Wend fomgey | By
[ [ Graphics S| by T
ﬁﬁ] [ Feter Bitmap Prinding
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The printer’s maximum image area is not available with the standard
LaserWriter paper sizes; use the Tektronix page sizes in the pop-up menu to
print the maximum image area. Refer to the table on page 5-2 for image area
information. Refer to your Apple documentation for details on the other
LaserWriter driver features in this dialog box.

Some applications override the Tektronix page sizes with their own
extensions in this dialog box. These application-specific page sizes obtain
page size and image area information about the Tektronix printer from the
printer description files. Refer to “Printing from an application” on page
2-16 for information on these files.

Phaser 540 GX Macintosh driver

The Paper options are located in the Page Setup dialog box.

Fage falup
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Tektronix driver for Windows 3.1

The Paper Size options are located in the Printer Setup dialog box. All the
sizes may not be available for every Windows application. For example,
Excel 3.0 can print only on the sizes listed in its Printer Setup dialog box.

-‘I Tek Fhaser 540 [TekColes] ea LPTE:

Fagar limecn Il‘q:nll Iﬂl or I
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Selecting media trays

The printer comes standard with one paper tray for U.S. or metric paper
sizes, depending on which tray you ordered. You can also add an optional
Lower Tray Assembly, which holds two additional media trays. Refer to the
Phaser 540 Color Printer User Manual for more information on optional
printer accessories.

The tray selection options let you specify the type of media you want to print
on, or specify which media tray you want to use if you have the optional
Lower Tray Assembly installed. You can select only one of these options.

Options Tektronix Downloadable  Printer’s front
driver settings  utility files panel settings

Upper

Prints on paper or transparencies loaded in the upper U U u
media tray.

Middle

Prints on paper or transparencies loaded in the middle U U 0
media tray.

Lower

Prints on paper or transparencies loaded in the lower g u g
media tray.

Paper

. . U n/a U
Prints on paper loaded in a paper tray.

Transparency

. ) . 0 n/a 0
Prints on transparencies loaded in a transparency tray.

Manual Feed Paper (Macintosh), or
Manual Paper (Windows)

Prints on paper loaded in the manual feed tray.
See page 5-8 for details.

O n/a O

Manual Feed Transparency (Macintosh), or
Manual Transparency (Windows)

Prints on transparencies loaded in the manual feed tray.
See page 5-8 for details.

O n/a O

AutoSelect

Automatically switches between media trays of the n/a 0 O
same type.

Printing Reference 55



5 Selecting Media and Image Options

5-6

Upper, Middle, and Lower selections

When you select the upper, middle, or lower tray, the printer picks media
from the selected tray until it is empty. At that point, printing stops until
you fill the selected tray.

Paper and Transparency selections

When you select Paper, the printer picks paper from a paper tray. When that
tray is empty, the printer switches to another paper tray, if one is installed.
Otherwise, printing stops until you fill the tray. If a paper tray is not
installed, the printer waits until you install one before it prints the job.

The Transparency selection is similar to the Paper selection. In this case, the
printer picks transparencies from a transparency tray. When that tray is
empty, the printer switches to another transparency tray;, if one is installed.
Otherwise, printing stops until you fill the tray. If a transparency tray is not
installed, the printer waits until you install one before it prints the job.

AutoSelect option

With AutoSelect, the printer picks media from the tray that contains the
media type (paper or transparency) that you selected in the printer driver.
When that tray is empty, the printer automatically picks from another tray of
the same media type, if one is installed.

Note  Selecting a tray from the driver overrides the front panel setting
or the utility file sent to the printer.
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Selecting media trays

5

Method Platform Location Selections
Tektronix printer Macintosh = Phaser 540 driver: = Upper
drivers The Tray Selection options are inthe = Middle
TekColor Options dialog box. = Lower
See page 2-6 for instructions. = Paper

= Phaser 540 GX driver: = Transparency

The Tray Selection options are in the
TekColor printing extension.

See page 8-20 for instructions.

Windows 3.1 Tektronix driver for Windows 3.1 = Upper Tray
installed for the Phaser 540: = Middle Tray
The Paper Source options are in the = Lower Tray
Printer Setup dialog box. » Paper
See page 3-9 for instructions. For = Transparency
details on the manual feed options, see
page 5-8.
Downloadable utility Macintosh = All Macintosh users: = Use Upper Tray
files Use the LaserWriter Utility to » Use Middle Tray
download these files to the printer. = Use Lower Tray
See page 2-12 for instructions. » Use Any Tray

» QuickDraw GX users:

Use the Tektronix Phaser 540 GX
driver to download these files to

the printer.
See page 8-13 for instructions.

PC/workstation = Use the DOS COPY command to s UPPRTRAY.PS
download these files to the printer. « MIDDTRAY.PS
See page 3-20 for instructions. s LOWRTRAY.PS

= Use the Windows File Manager to = ANYTRAY.PS
download these files to the printer.

See page 3-21 for instructions.

Printer’s front panel All Use the Printer Defaults menu. = Default Tray:Upper
Refer to the Phaser 540 Color Printer = Default Tray:Middle
User Manual for instructions. = Default Tray:Lower

For details on the manual feed options, = Default Tray:Paper

see page 5-8. = Default Tray:Transparency
= Default Tray:AutoSelect
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Printing manual feed

5-8

Options Tektronix Downloadable Printer’s front panel
driver settings  utility files settings
Manual feed paper O n/a Default Tray:
Manual Feed Paper
Manual feed Il n/a Default Tray:
transparencies Manual Feed Transparency

You can use a Tektronix driver or the printer’s front panel to print on paper
or transparency film that you feed manually into the printer. Refer to the
Phaser 540 Color Printer User Manual for instructions on loading media.

Note  Colors may not print as expected if the loaded media does not
match the selected media type.

To print with manual feed from a Tektronix printer driver, you may need to
make selections in two different dialog boxes.

Phaser 540 Macintosh driver (based on LaserWriter 7.1.2)
1. Select the Manual Feed option in the Print dialog box.

2. Choose Paper or Transparency from the Manual Feed Media
pop-up list in the TekColor Options dialog box.

Phaser 540 GX Macintosh driver
1. Select the Manual Feed option in the Print dialog box.

2. Select Paper or Transparency from the Manual Feed Media
pop-up list in the TekColor printing extension dialog box.

Tektronix driver for Windows 3.1

Choose Manual Paper or Manual Transparency from the Paper Source
pop-up list in the Printer Setup dialog box.
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Manual feed printing

Method Platform Location Selections
Tektronix printer Macintosh = Phaser 540 driver: = Paper
drivers The Manual Feed Media options are = Transparency

in the TekColor Options dialog box.
See page 2-6 for instructions.
= Phaser 540 GX driver:

The Manual Feed Media options are
in the TekColor printing extension.

See page 8-19 for instructions.

Windows 3.1 Tektronix driver for Windows 3.1 = Manual Paper
installed for the Phaser 540: = Manual Transparency

The Paper Source options are in the
Printer Setup dialog box.

See page 3-9 for instructions.

Printer’s front All Use the Printer Defaults menu. = Default Tray:
panel Refer to the Phaser 540 Color Printer Manual Fee.d Paper
User Manual for instructions. = Default Tray:

Manual Feed Transparency
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Selecting print quality

Options Tektronix Downloadable  Printer’s front
driver settings utility files panel settings
Fast
g g g

Prints 300 x 300 dots-per-inch

Standard or Enhanced
Prints 600 x 600 dots-per-inch

These three print quality modes affect the quality of printed images and the
time they take to print. The higher quality modes, Standard and Enhanced,
typically take longer to print than Fast mode:

(] Fast
This is the fastest full-color mode and is useful for
many applications. Images print at a resolution of
300 x 300 dots-per-inch.

= Standard
Images print at a resolution of 600 x 600 dots-per-inch. Standard is
the default mode for the printer.

= Enhanced
This mode produces the best quality prints, but takes
longer to process and print. Images print at a resolution of
600 x 600 dots-per-inch. To use this mode, you must have the
16-Mbyte optional memory kit installed in the printer. Without
the additional memory installed, the printer uses Standard mode
when you select Enhanced.
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Selecting print quality

Method Platform Location Selections

Tektronix printer drivers Macintosh = Phaser 540 driver: = Fast

The Print Quality optionsarein = Standard
the TekColor Options  dialog ., Ephanced
box.

See page 2-6 for instructions.
= Phaser 540 GX driver:

The Print Quality optionsarein
the TekColor printing
extension.

See page 8-20 for instructions.

Windows 3.1 Tektronix driver for Windows = Fast
3.1 installed for the Phaser 540: Standard

The Print Quality options are in = Enhanced
the Tektronix Printer Features
dialog box.

See page 3-11 for instructions.

Downloadable utility files Macintosh = All Macintosh users: = Fast Quality
Use the LaserWriter Utility to = Standard Quality
download these files to the « Enhanced Quality
printer.

See page 2-12 for instructions.

= QuickDraw GX users:

Use the Tektronix Phaser 540
GX driver to download these
files to the printer.

See page 8-13 for instructions.

PC/workstation Use the DOS COPY commandto = FAST.PS
download these files to the printer. | sTANDARD.PS

See page 3-20 for instructions. = ENHANCED.PS

Use the Windows File Manager to
download these files to the printer.

See page 3-21 for instructions.

Printer’s front panel Use the Print Quality menu. = Print Quality:Fast
Refer to the Phaser 540 Color = Print Quality:Standard
Printer User Manual for = Print Quality:Enhanced
instructions.

Printing Reference 5-11



5 Selecting Media and Image Options

Selecting image orientation

The Orientation option in the Tektronix Macintosh and Windows drivers
lets you choose the direction in which your document is placed on the paper.
Refer to the Phaser 540 Color Printer User Manual for more information on
image placement and paper loading.

Select the orientation option you want to use for your prints:

= Portrait: Prints your image vertically on the media.

= Landscape: Prints your image horizontally on the media.

Phaser 540 Macintosh driver (based on LaserWriter 7.1.2)

The Orientation option is located in the Page Setup dialog box.

I
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Phaser 540 GX Macintosh driver

The Orientation option is located in the Page Setup dialog box.
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Tektronix driver for Windows 3.1

The Orientation option is located in the Printer Setup dialog box.

=| Tek Phaser 540 [TekColor] on LPT1:
Paper Source: |Paper |£I I oK I
Paper Size: |Letter 85x11in |£| | Cancel I
Orientation ] ¢ o Options...

® Portrait

. Landscape
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Choosing the output (stack) order

The Output Face Up check box in the Tektronix Macintosh and Windows
drivers lets you specify whether your document prints face up or face down.

Note  When printing on transparencies, the printer automatically
prints your document face up.

= To print your document face up, stacking the pages so that the first
page is on the bottom, check on the Output Face Up check box.

= To print your document face down, stacking the pages face down
in numerical order, check off the Output Face Up check box.

Note  The default for the Output Face Up check box is on.

Phaser 540 Macintosh driver (based on LaserWriter 7.1.2)
The Output Face Up option is located in the TekColor Options dialog box.
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Phaser 540 GX Macintosh driver

The Output Face Up option is located in the Printer Driver Defaults
dialog box, or the TekColor printing extension dialog box.

Phiasds 580 Balaalls: 'lhl:lmn:’!x
Calgr Cpevecfion | Wase - |
Trag Selectiesc | Paper 7]
Friml Ppadiy [ Hangard - |
rigmped Feed Media; [_Paper -]

[ Dutput Fate Up

| Help | | Cemtei | f| ok ]

Tektronix driver for Windows 3.1

The Output Face Up option is located in the Tektronix Printer Features
dialog box.

Tektronix Printer Features

Color Correction: |Vivid Color |£| 1] 4 I
Print Quality: |Standard |£I Cancel I

& Output Face Up?
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Chapter

Using Color

TekColor Dynamic Correction

This chapter explains how to select colors and how to make color corrections
on your prints. It also includes instructions for printing and using the color
sampler charts provided on the diskettes shipped with the printer.

The TekColor color corrections provide simulations of different
color devices:

= Vivid Color and Simulate Display options for business,
engineering, and scientific imaging applications.

= Three printing press standards for graphic arts use.

These color corrections are driver-selectable from Macintosh and Windows
applications using the Tektronix printer drivers. You can also set color
corrections using the downloadable utility files or the printer’s front panel.

Note  TekColor color corrections do not affect colors specified in the
PostScript Level 2 international color standard CIE XYZ
developed by the Commission Internationale de I’Eclairage
(International Commission on Illumination).

Printing Reference 6-1



6 Using Color

Working with color

6-2

You probably purchased your color printer with some idea of how you
wanted to use color in your work. Whether you are producing color
overhead transparencies for presentations, color handouts or reports, or
design comps, there are a few things to keep in mind when using color.
Colors look different depending on the size of the color area, the
surrounding colors, and the lighting conditions.

A large area of color looks more saturated (brighter) than a small
area of the same color.

A color looks brighter against a dark background than it does
against a white background.

Colors look different due to the background color or to the
surrounding colors.

The appearance of a color varies with the type and amount of
light; for example, fluorescent lighting versus sunlight.

General guidelines

Keep it simple and consistent.

Select colors that look good together and that reinforce your
message.

Check your application for standard palettes to get you started.
Use a color scheme of five or six shades and use the colors in a
consistent manner throughout a series of images.

Use color to highlight the most important information, such as a
bar or pie segment in a chart or graph.

Use color to show relationships between objects, such as a range of
values. Objects with a similar meaning or value should be in
similar colors.

Use color as graphic elements in the design of newsletters, logos,
and brochures.

Avoid red and green combinations; these colors are hard for
people with red/green color blindness to distinguish.
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Using color in presentations

When used consistently, color in your presentations helps your audience
remember key points. For example, graphics that represent your product
should always appear in the same color. If you represent data graphically, be
sure to put the most important data in red or the brightest, warmest color in
your selected palette. Put the data you do not want to emphasize in

cool colors.

Color design guidelines:

= Keep it simple; use up to seven colors maximum.
s Use color to indicate related elements.

= Use complementary colors for basic color schemes; use split
complements for more subtle effects.

= Avoid blue/red and yellow/purple combinations.
= Use full-strength warm colors sparingly for emphasis.

= Use acool, dark background color that won’t compete with the
foreground. Use foreground colors that stand out clearly against
the background. Research indicates that blue is the most preferred
background color, followed by black, gray, brown, red, green, and

purple.

Text and font guidelines:

= For readability, use dark text on a lighter background, or light text
on a darker background. For example, white or yellow text with a
deep blue background.

= Use bold text for emphasis.
m  Textsizes to use for overhead transparencies or slides:
Use a 40-point or larger font for titles.

Use 24- to 36-point fonts for body text.
Use 5 to 7 lines of text maximum per slide or overhead.
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Selecting color corrections

Color printers and computer screens produce color differently. Printers use
the subtractive primaries CMYK (cyan, magenta, yellow, and black), and
produce color when light is reflected off the paper. Computers use the
additive primaries RGB (red, green, blue) with a light-emitting CRT screen.
The printer and the computer screen each have a different range of possible
colors they can produce, with some overlap between them.

Software application packages specify color in different ways, for example,
as CMYK or RGB, or they may give you a choice. Get to know your
applications so you can get the most out of them.

The TekColor color correction options are available for a finer degree of
control over colors. Since no single color correction option can address all
uses, refer to the following table for the description that best fits your
printing situation, and try the suggested color correction.

Printing objective or problem Color correction to use Where to
find details

Overhead transparency presentations. Vivid Color page 6-8
Blue colors are printing too purple. Vivid Color page 6-8
Using PANTONE Colors. None page 6-17
Colors should match computer display screen. Simulate Display page 6-8
Colors should match a printing press. Commercial Press page 6-9

Euroscale Press

SWOP Press
Colors are too dark. Simulate Display page 6-8
Colors are washed out or faded. Vivid Color page 6-8
Print in gray scale. Monochrome page 6-10
Use printer’s current color defaults. Use Printer Setting page 6-10
Use simple CMYK conversion. Raw CMYK Colors page 6-11
Use simple RGB conversion. Raw RGB Colors page 6-11
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If your Phaser 540 printer is shared by other users on a network

Another user may use the utility files or the printer’s front panel to change
the printer’s default color correction setting. If this situation occurs, the
prints you make through a non-Tektronix driver may not print as expected.
Refer to “Sharing the printer on a network” on page 9-20 for details on how
the color corrections interact with the driver settings for either Tektronix or
non-Tektronix drivers.

Application color corrections

Some applications perform color corrections to improve screen-to-printer
color matching. The color correction options in the Tektronix drivers adjust
colors in the printer after the application has performed its color corrections.

= If the application uses CIE (Commission Internationale de
I’Eclairage) colors, the Tektronix corrections will not be applied.

= If you select a color correction option in the driver other than
None, the selection may override some application features.

= If you try one of the driver’s other options and the printed results
are not what you expected, select the None option and try
reprinting your image with the new setting.

If you are using a non-Tektronix driver

To use the color corrections with a non-Tektronix driver, use the
downloadable utility files or the printer’s front panel.
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Color corrections table

6-6

Options Tektronix Downloadable  Printer’s front
driver settings utility files panel settings
None 0 0 0

(turn off all color corrections)

Vivid Color
(print a truer blue) O 0 0

Simulate Display

(simulate display screen U U U
colors)

SWOP Press O O O
Euroscale Press O O U
Commercial Press O | O
(closely match printing press

colors)

Monochrome 0 0 0

(print in gray scale)

Use Printer Setting

(use the printer’s current color 0 n/a n/a
defaults)

Raw CMYK n/a 0 n/a
Raw RGB n/a O n/a

(use simple color conversions)

Note A setting made in the driver overrides the front panel setting for
prints made from the driver. However, the driver’s Use Printer
Setting option allows you to use the current front panel selection
or downloaded utility file.
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Selecting color corrections
Method Platform Location Selections
Tektronix printer Macintosh = Phaser 540 driver: = None
drivers The Color Correction options are inthe . Vivid Color
TekColor Options dialog box. « Simulate Display
See page 2-6 for instructions. « SWOP Press
= Phaser 540 GX driver: = Euroscale Press
The Color Correction options are inthe . commercial Press
TekColor printing extension. « Monochrome
See page 8-20 for instructions. = Use Printer Setting
Windows 3.1 Tektronix driver for Windows 3.1
installed for the Phaser 540:
The Color Correction options are in the
Tektronix Printer Features dialog box.
See page 3-11 for instructions.
Downloadable Macintosh = All Macintosh users: = No Color Correction

utility files

Use the LaserWriter Utility to download
these files to the printer.

See page 2-12 for instructions.

= Vivid Color
= Simulate Display
= SWOP Press

= QuickDraw GX users:

Use the Tektronix Phaser 540 GX driver

to download these files to the printer.
See page 8-13 for instructions.

= Euroscale Press
» Commercial Press
= Monochrome

= Raw CMYK Colors
= Raw RGB Colors

PC/workstation

= Use the DOS COPY command to
download these files to the printer.

See page 3-20 for instructions.

» COMRCIAL.PS

= DISPLAY.PS

» EUROSCALE.PS
= NOCORECTPS

= Use the Windows File Manager to
download these files to the printer.

See page 3-21 for instructions.

= RAWCMYK.PS

» RAWRGB.PS

» SWOPRESS.PS
= VIVDCOLR.PS

= MONOCHRM.PS

Printer’s front
panel

Use the TekColor Corrections menu.

Refer to the Phaser 540 Color Printer User

Manual for instructions on using the front
panel.

= TekColor:None

= TekColor:Vivid Color
= TekColor:Display

= TekColor:SWOP

= TekColor:Euroscale
= TekColor:Commercial

= TekColor:Monochrome

Printing Reference
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Turning off all color corrections

If you do not want to use any Tektronix color corrections, you can specify no
corrections from a Tektronix driver, with utility files, or from the printer’s
front panel. Select no corrections when you are using applications that do
their own color adjusting.

Printing a truer blue

The Vivid Color option makes printed blue appear less purple by reducing
the amount of magenta used to print blue colors. Other colors in the
cyan-blue-purple-magenta range are also adjusted to compensate for the
adjusted blue. Colors in the red-orange-yellow-green range are not affected.
This selection is good for making presentation graphics, such as overhead
transparencies, and for bright-looking colors that don’t need to match the
screen’s colors or printing press colors.

Vivid Color adjusts CMYK colors using a method that adds black to other
components. This option prints more saturated (darker) colors and can be
useful for printing overhead transparencies for presentations from some
applications, such as CorelDRAW!. Use this option if you have specified a
color in the CMYK system and the following conditions are true;

= The color has a black component.

= The color appears lighter than you expected when printed.

Simulating display colors

The Simulate Display option makes printed colors approximate the colors
on a standard display screen. This selection should improve the
screen-to-printer color accuracy for most applications that don’t perform
their own color corrections. This selection is best for applications that define
colors as one of the following:

= RGB (red, green, blue).
= HLS (hue, lightness, saturation).

= HSB (hue, saturation, brightness).
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Closely match printing press colors

There are three printing press color correction options. Each press option
conforms to a different printing standard. Use a press option if you are
previewing work for a four color job to be printed on a printing press. These
options simulate a four-color commercial printing press, not solid spot
colors, such as PANTONE Colors.

Note  If you are selecting PANTONE Colors in your application, use
the None option; see page 6-17 for details. Also use the None
option with other color management systems, such as EfiColor.

Select a press option based on the type of commercial printing process you
will be using for your final print job. Use the following list and table to help
you determine when to use each option.

= SWOP Press (Specifications for Web Offset Publications)
This refers to specifications for color separation films and color
proofing that are used to ensure the consistency of printed colors
between different publications. This option is typically used in
the U.S., and is targeted to match nominal values for this type
of printing.

= Commercial Press
This option is typically used in the U.S., and is characterized to
match commercial 3M Matchprint® proofs.

= Euroscale Press
This option is typically used in Europe, and is characterized to
match the Pantone Process Color System Guide, Euroscale Edition.

Press mode option Inks Base (paper) Target match

SWOP Press

SWOP/soy publication Specification for Web Offset Publications

(Tends to be high-volume, web press printing.)

Commercial Press

commercial commercial Commercial pre-press proofs

(Tends to be high-quality, sheet-fed printing.)

Euroscale Press

Euroscale  publication Pantone Process Color System Guide,
Euroscale Edition
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Printing in gray scale
The Monochrome option prints your color image as a monochrome gray

scale (shades of gray between black and white). Use this option to print
page masters for photocopying in black-and-white.

Using the printer’s current color defaults
The Use Printer Setting option is available only in the Tektronix Macintosh

and Windows drivers. This option sends no color correction to the printer.

It uses the current default in the printer to process colors for printing. The
printer’s defaults can be one of the following:

= Any option selected in the TekColor Corrections menu on the
printer’s front panel.

= One of the color correction utility files sent to the printer.
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Using simple color conversions

The following utility files use Adobe’s standard color conversions to tell the
printer what type of output device you want it to simulate:

= Raw CMYK Colors (RAWCMYK.PS)
Converts all colors (CMYK, RGB, grays) to CMYK colors. Use this
file if your application specifies colors as CMYK (cyan, magenta,
yellow, and black). This file lets you control the CMYK output of
the printer’s colors without any TekColor color corrections.

= Raw RGB Colors (RAWRGB.PS)
Converts all colors (CMY, CMYK, grays) to RGB colors. Use this
file if your application specifies colors as RGB (red, green, and
blue). This file lets you control the CMY output of the printer’s
colors without any TekColor color corrections.
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6 Using Color

Printing the color sampler charts

You can select colors within an application using color component values.
Which color chart you print and use depends on how the application you are
using selects color. Refer to the application’s documentation for information
on color selection, then print one of the charts listed in the table below.

6-12

= The Macintosh files are located in the compressed Phaser 540
Samplers.sea archive file on the Macintosh Driver and Printer
Utilities diskette; refer to page 2-11 for decompressing

instructions.

= The PC files are located in the SAMPLERS directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

Color sampler chart files

Color sampler chart Number of Macintosh file name PC file name
printed pages

Print a sample of CMYK colors 18 CMYK Sampler CMYK.PS

Print a sample of RGB colors 12 RGB Sampler RGB.PS

Print a sample of HSB colors 12 HSB Sampler HSB.PS

Print a sample of PANTONE Colors 46 PANTONE-Tek Phaser 540 PANT540.PS
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The color sampler charts are made up of areas of color with each color’s
components listed below it. Each color sampler chart is several pages long;
they are printed in panels that can be connected to form a wall chart or
placed in a binder for easy reference.
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Before you print the CMYK, RGB, and HSB color charts

To match colors on the charts to colors selected within an application, use the
same printer color correction to print the charts that you are going to use
when selecting and printing these colors within an application.

For example, if you are going to print from an application using the driver’s
Vivid Color option, print the color chart with the Vivid Color
(VIVDCOLR.PS) utility file or with the Vivid Color (TekColor Corrections
menu) front panel selection. Or, if you are not using a Tektronix driver, use
the same utility file or front panel setting to print the chart and to print from
an application.

The following table lists the driver color correction settings with their
corresponding utility files or front panel settings.

Driver, utility file, and front panel settings

Driver setting Macintosh utility PC utility Printer’s front panel setting

(Macintosh and Windows) file name file name (TekColor Correction menu)

Simulate Display Simulate Display DISPLAY.PS Display

Vivid Color Vivid Color VIVDCOLR.PS Vivid Color

Use Printer Setting (any color correction (any color correction (any front panel color setting)**
utility file)** utility file)**

Commercial Press Commercial Press COMRCIAL.PS Commercial

Euroscale Press Euroscale Press EUROSCAL.PS Euroscale

SWOP Press SWOP Press SWOPRESS.PS SWOP

None No Color Correction NOCORECT.PS None

** Use the same color correction to print the chart and later to print the colors from an application.
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Printing the CMYK, RGB, and HSB color charts

Macintosh users

1.

Follow the instructions on page 2-11 to decompress the Phaser 540
Samplers.sea and the Phaser 540 Ultilities.sea archive files from the
Macintosh Driver and Printer Utilities diskette onto your hard
disk.

Select the appropriate printer in the Chooser.

Determine which front panel selection or color correction utility
file you want to use by examining the table on page 6-4.

Make the appropriate selection on the printer’s front panel, or use
the LaserWriter Utility to send the appropriate utility file to the
printer. For instructions on using the LaserWriter Utility to
download utility files, see page 2-12.

To print a color sampler chart, use the LaserWriter Utility to
download the desired color sampler chart file to the printer; see
page 2-12 for instructions.

Select colors within an application using the colors on the chart.

Print your document using one of the following methods:

= If you are printing from a Tektronix driver
Print your document using the Tektronix printer driver with the

6

same color correction option selected in the driver that you used to

print the chart. Any other color correction selection in the driver

can cause the colors to print differently.

= Ifyou are not using a Tektronix driver
Print your document with the same front panel color correction
selected or with the same color correction utility file sent to the
printer that you used to print the chart.
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PC and workstation users

1.

Copy the color sampler chart files that you want to use from the
SAMPLERS directory on the Tektronix Windows 3.1 Driver and
Printer Utilities diskette onto your computer’s hard disk. You
may want to place these files in a Utilities directory. Or, you can
download these files directly from the diskette.

Determine which front panel selection or color correction utility
file you want to use by examining the table on page 6-4.

Make the appropriate selection on the printer’s front panel, or
send the appropriate utility file to the printer. For instructions on
downloading utility files to the printer, see pages 3-20 and 3-21.

Use one of the following methods to print the color sampler
charts:

= PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the color sampler chart file to the printer
as you would any PostScript file.

Select colors within an application using the colors on the chart.
Print your document using one of the following methods:

= Ifyou are printing from a Tektronix driver
Print your document using the Tektronix printer driver with the
same color correction option selected in the driver that you used to
print the chart. Any other color correction selection in the driver
can cause the colors to print differently.

= Ifyou are not using a Tektronix driver
Print your document with the same front panel color correction
selected or with the same color correction utility file sent to the
printer that you used to print the chart.
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Printing the PANTONE

Note

Using Color 6

Color chart

Do not use any color corrections in a driver, or with a
downloadable utility file, or from the printer’s front panel, when
printing the PANTONE Color chart or when printing
PANTONE Colors from an application. Using color corrections
causes the PANTONE Colors to print incorrectly.

The PANTONE-Tek Phaser 540 (PANT540.PS) file prints a PANTONE Color
sampler chart (about 46 pages in length). Use the chart to select colors
within an application that allows you to specify PANTONE Colors.

Macintosh users

1.

Follow the instructions on page 2-11 to decompress the Phaser 540
Samplers.sea and the Phaser 540 Utilities.sea file from the Macintosh
Driver and Printer Utilities diskette onto your hard disk.

Select the appropriate printer in the Chooser.

Select the None option in the TekColor Corrections menu on the
printer’s front panel, or send the No Color Correction utility file to
the printer.

To print the chart, use the LaserWriter Utility to download the
PANTONE-Tek Phaser 540 file to the printer (see page 2-12 for
instructions).

Select PANTONE Colors within an application using the colors on
the chart.

Print your document using one of the following methods:

= Ifyou are printing from a Tektronix driver: Print your document
with the None option selected. Any other color correction selection
in the driver causes the PANTONE Colors to print differently.

= Ifyou are not using a Tektronix driver: Print your document with
the None option selected in the TekColor Corrections menu on the
printer’s front panel, or send the No Color Correction utility file to
the printer.
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PC and workstation users

Copy the PANT540.PS sampler file from the SAMPLERS directory
on the Tektronix Windows 3.1 Driver and Printer Utilities diskette
onto your computer’s hard disk. You may want to place this file in
a Utilities directory. Or, you can download this file directly from
the diskette.

1.

Select the None option in the TekColor Corrections menu on the
printer’s front panel, or send the NOCORECT.PS file to the printer.

Use one of the following methods to print the PANTONE Color
chart:

PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the PANT540.PS sampler file to the
printer. See page 3-20 and page 3-21 for details.

Workstation users: Send the PANT540.PS file to the printer as you
would any PostScript file.

Select PANTONE Colors within an application using the colors on
the chart.

Print your document using one of the following methods:

If you are printing from a Tektronix driver: Print your document
with the None option selected. Any other color correction selection
in the driver causes the PANTONE Colors to print differently.

If you are not using a Tektronix driver: Print your document with
the None option selected in the TekColor Corrections menu on the
printer’s front panel, or send the NOCORECT.PS utility file to the
printer.
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Chapter

Using Fonts

This chapter explains how to use fonts and print a font sampler in the
Macintosh and PC environments.

Note  For general information on fonts, request a document catalog
from HAL or EuroHAL, the Tektronix automated fax systems.
Refer to page 9-2 for instructions on using these systems.

Macintosh fonts

Using Macintosh screen fonts

Note If you already have these fonts installed on your computer, you
don’t need to install them again.

The Phaser Screen Fonts.sea archive file on the Macintosh Driver and Printer
Utilities diskette contains screen fonts in the following typeface families:
Courier, Helvetica, Helvetica Condensed, Helvetica Narrow, ITC Avant
Garde Gothic, ITC Bookman, ITC Zapf Chancery, ITC Zapf Dingbats, New
Century Schoolbook, Palatino, Symbol, and Times.

You need to decompress and install the screen fonts on your computer if you
want to see the printer’s resident typefaces on the Macintosh screen. If you
select a font the printer doesn’t have, the Macintosh creates a representative
font for printing.
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Decompressing the fonts

Note Do not decompress fonts directly into the System Folder; they
must be properly installed after they have been decompressed onto
your hard disk.

1. Insert the Macintosh Driver and Printer Utilities diskette into your
computer’s disk drive.

2. Double-click on the Phaser ScreenFonts.sea archive file.
3. Atthe Self-Extracting Archive dialog box, click Continue.

4. In the dialog box, select the drive where you want the
decompressed fonts saved.

5. Atthe Install software as: prompt, you are asked to name
the folder where you want the decompressed fonts to reside. Use
the default folder name listed in the edit box, or type in the name
you want for the folder. Then click Save.

6. Atthe Installation was successful dialog box, click Quit. The
decompressed fonts are saved in the folder you specified.

Installing the decompressed fonts

System 6.0.7 users
Use the Font/DA Mover (located on your Apple system software diskettes)
to install the fonts you want from the Phaser Screen Fonts suitcase.

System 7.0, and later, users

Drag the fonts you want from the Phaser Screen Fonts suitcase to the closed
System Folder icon. At the alert message, click OK; the fonts are
automatically installed in the proper place.

Select the printer font you want to use within an application and see the
same font on the screen.
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Downloading fonts to the printer from a Macintosh

The fonts resident in the printer are stored in the printer as outlines and are
always available for printing. The PostScript interpreter in the printer can
also accept and store additional fonts known as downloadable fonts. If you
want to print PostScript outline fonts that are not built into the printer, you
can transfer or download outline fonts from your computer to the printer.
Downloading fonts saves print time if you plan to print several documents
or a large document using those fonts.

When you download a font, it is stored in the printer’s memory. You can
download as many outline fonts as the printer’s memory allows.

1.

If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

Double-click on the LaserWriter Utility icon.

To send fonts to the printer, use the Download Fonts command in
the File menu.

(To send PostScript files to the printer, refer to “Using the
LaserWriter Utility to download files to the printer” on page 2-12.)

Select the font, then click Open. The font is sent to the printer.
The font remains available until the printer is reset or switched off.
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Printing a font sampler from a Macintosh

You can print a sample of the printer’s resident fonts by downloading the
Fonts Sampler utility file to the printer.

1. If you have not decompressed the Phaser 540 Utilities.sea archive
file and the Phaser 540 Samplers.sea archive file on the Macintosh
Driver and Printer Utilities diskette, follow the instructions on
page 2-11 to decompress these files.

2. Select the appropriate printer in the Chooser.

3. Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

4. Double-click on the LaserWriter Utility icon.
5. Select Download PostScript File from the Utilities menu.

6. Select the Fonts Sampler file in the folder on your hard disk
containing decompressed utility files and click Open.

7. Atthe Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Then click Save
to send the file to the printer.

8. If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the dialog box.
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PC fonts

Using fonts with Windows

Before printing, you need to make sure the fonts specified in your document
are installed in the printer or set up correctly in Windows. If you request a
font in an application that is not resident in the printer or is not installed
properly in Windows, the text is printed in the Courier typeface.

To use fonts that are not resident in the printer, do one of the following:

= Use a font downloader supplied with your font package to
download the desired font to the printer.

= Edit your WIN.INI file so that the Tektronix Windows driver
automatically downloads the fonts you want as part of a print job.
Refer to your Microsoft Windows documentation for details on
this procedure.

Some font packages automatically update the PostScript port
entries in your WIN.INI file when you reinstall the fonts. Refer to
the font package’s documentation for instructions.

For more information on using fonts with Windows, check the HAL or

EuroHAL document catalog for articles. Refer to page 9-2 for instructions on
using Tektronix’s automated fax systems.
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Downloading fonts to the printer from a PC

The fonts resident in the printer are stored in the printer as outlines and are
always available for printing. The PostScript interpreter in the printer can
also accept and store additional fonts known as downloadable fonts. If you
want to print PostScript outline fonts that are not built into the printer, you
can transfer or download outline fonts from your computer to the printer.
Downloading fonts saves print time if you plan to print several documents
or a large document using those fonts.

When you download a font, it is stored in the printer’s memory. You can
download as many outline fonts as the printer’s memory allows.

A font downloader is an interactive program that lets you transfer Adobe
fonts and other PostScript files to the printer. Check your font package for a
downloader application. Or, check the Tektronix Bulletin Board Service
(BBS) for a PC font downloader; refer to page 9-1 for instructions.

Printing a font sampler from a PC

You can print a sample of the printer’s resident fonts by downloading the
FONTS.PS utility file to the printer.

1. Locate the FONTS.PS file in the SAMPLERS directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

2. Copy the file to your hard disk, or use the file from the diskette.
3. Use one of the following methods to send the file to the printer:
= PCusers: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Chapter

Using the
Phaser 540 GX Driver

If you are using Apple System Software 7.5 and QuickDraw GX, use the
Phaser 540 GX driver to print to your Phaser 540 printer.

= The Phaser 540 GX driver works with QuickDraw GX and
non-QuickDraw GX applications.

= QuickDraw GX doesn’t work with non-QuickDraw GX printer
drivers. To print from non-QuickDraw GX applications using the
Tektronix Phaser 540 driver (based on the LaserWriter 7.1.2.
printer driver) described in Chapter 2, you must disable

QuickDraw GX. See page 8-22 for instructions on disabling
QuickDraw GX.

System requirements

Note  You must have an optional Phaser Share Card installed in the
printer before installing the driver.

The Tektronix Phaser 540 GX printer driver requires the following hardware
and software;

= An Apple Macintosh Il computer, or later
= At least 8 Mbytes of memory

= System Software version 7.5 and QuickDraw GX
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Installing the QuickDraw GX Phaser 540 printer driver

1. Make sure your Macintosh is turned on with System Software
version 7.5 and QuickDraw GX installed.

2. Insert the Macintosh Driver and Printer Utilities diskette into the
disk drive.

3. When the diskette appears on the desktop, it should be open
showing the icons inside.

4. Drag the Phaser 540 GX driver icon from the diskette to the closed
System Folder icon on your Macintosh hard disk. At the alert
message, click OK to automatically install the driver in the
Extensions folder.

5. Store the printer diskette in a safe place.

Note  Before you can print, you need to create a desktop printer; proceed
to “Creating a desktop printer”” on page 8-3 for instructions.
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Creating a desktop printer

1. Select Chooser from the Apple menu.
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2. Click the Phaser 540 GX printer driver icon on the left side of the
Chooser. A list appears with the printers available on your
network. (If the printer driver icon does not appear, Restart your
Macintosh, and repeat the printer driver installation procedure;
also check the cable connections on your computer and printer.)

3. Inthe Connect via field’s pop-up menu, select your printer’s
communication method:

= The AppleTalk option is the standard network connection.

= The Servers option is used to select a shared desktop printer; see
page 8-15 for details.

4. Click on your printer in the list on the right side of the Chooser.
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5. If you want to rename the printer listed in the Chooser, do so
before creating any desktop printers. If you rename the printer in
the Chooser, any desktop printers referring to that printer will not
work, and must be removed to the Trash and re-created.

See page 2-15 for instructions on using the LaserWriter Utility to
rename the printer.

6. Click the Create button to create a desktop printer. An icon of the
printer appears on the desktop with the same name as the printer
selected in the Chooser.

7. Close the Chooser by clicking its close box.
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Using a desktop printer

You can create more than one desktop printer of the same physical printer.
Then, set up each desktop printer with different print modes or options that
you use frequently, and give each desktop printer a descriptive name. This
allows you to print quickly to a specific printer with your favorite options
already selected.

Setting up unique desktop printers

1. Create a desktop printer using the instructions on page 8-3.

2. Select (highlight) a desktop printer icon. The Printing menu
appears in the menu bar at the top of the Macintosh screen.

il Feanl beted
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3. Use the Printer Driver Defaults command in the Printing menu
to select options for individual desktop printers. See page 8-10 for
details.

4. To rename the desktop printer, highlight the icon on the desktop
and type a new name. (Renaming a desktop printer has no effect
on the printer name in the Chooser.)

fd

Phazer S40-Yivid Colar-Paper
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Printing with a desktop printer

If you are using GX-aware applications
= Select any desktop printer in the Print dialog box.

= Drag a document onto a desktop printer icon. The application
corresponding to the document opens, prints the document, and
then quits.

If you are using non-GX-aware applications

= Print to the default desktop printer using the Print command on
the File menu.

= Drag a document onto a desktop printer icon. The application
corresponding to the document opens the Print dialog box and
waits for you to click Print. After printing the document, the
application quits.
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Using the Printing menu

Most of the commands in the Printing menu are standard QuickDraw GX
driver commands, and are documented by Apple (see the Macintosh Guide
on-line document for details). The last group of commands in this menu are
printer-specific.
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Controlling printing

Use the Start Print Queue and Stop Print Queue commands in the Printing
menu to control the print queues on individual desktop printers.

1. Select (highlight) a desktop printer icon.

2. From the Printing menu, select the appropriate command.
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8-8

Designating a default desktop printer
1. Select (highlight) a desktop printer icon.

et}

FPhazer 240

2. From the Printing menu, select Set Default Printer.
A check-mark appears next to the command, and a bold outline
appears around the desktop printer icon.

Lep]

FPhaser 240
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Controlling input trays

If you select the Input Trays command in the Printing menu, you will see
the following message appears:

Please use the Printer Driver Defaults command to
specify media options for this printer.

Click OK to continue, then use the Printer Driver Defaults command in the
Printing menu to select media trays.

Using printing extensions

Use the Extension Setup command in the Printing menu to specify which
third-party printing extensions you want enabled for the currently selected
desktop printer. For example, Print Time and Paper Match are part of the
QuickDraw GX software and are always available. By default, all printing
extensions are enabled.

fnlension seiup
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1. Select (highlight) a desktop printer icon.
2. Select Extension Setup from the Printing menu.

3. Make selections as desired.
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Selecting printing options

Use the Printer Driver Defaults command in the Printing menu to set
default options for the selected desktop printer. This dialog box includes the
color corrections, tray selections, and print quality modes.

[ Duiftput Faste Up
| Help |
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Note  The printer defaults dialog box is also available through the Print
command on the File menu for QuickDraw GX-aware
applications.
Phaser 540 Defaults  Options Where to find
details
Color Correction = None = Euroscale Press Chapter 6
= Vivid Color = Commercial Press
= Simulate Display = Monochrome
= SWOP Press = Use Printer Setting
Tray Selection = Upper Tray Chapter 5
= Middle Tray
= Lower Tray
= Paper
= Transparency
Print Quality = Fast Chapter 5
= Standard
= Enhanced
Manual Feed Media = Paper Chapter 5

= Transparency
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Downloading printer utilities

Use the Printer Utilities command in the Printing menu to download
printer utility files to the selected desktop printer. This command cannot be
used on a shared printer, except by the Macintosh hosting the shared printer;
the command is not visible in the menu.

1. Select (highlight) a desktop printer icon.
2. Select Printer Utilities from the Printing menu.

3. In the Utility pop-up menu, select the file you want downloaded
to the printer, then click OK.

Printer URilities: Th]:lmu_;x
Fimig | Prind Elariwe Pape - |
[Caatil | l 0k I

4. 1f you see an alert message, click OK or Cancel.
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The utilities in the following table can be downloaded to the printer using
the Printer Utilities command in the Printing menu.

Utilities Where to find details
= Print Startup Page Appendix A
= Print Configuration Page

= Print CMYK Sampler Chapter 6

= Print HSB Sampler

= Print RGB Sampler

= Print Fonts Sampler Chapter 7

= Disable Startup Page Appendix A
= Enable Startup Page

= Disable SysStart Job Appendix A
= Enable SysStart Job

= Download Tek Error Handler Chapter 9

= Download Setscreen Patch

= Initialize Printer Disks Appendix B
= Format Printer Disks

= Reset Printer Chapter 9

= Use Lower Tray Chapter 5

= Use Middle Tray

= Use Upper Tray

= Use Any Tray

= Use Fast Quality Chapter 5

= Use Standard Quality

= Use Enhanced Quality

= Enable No Color Corrections Chapter 6

= Enable Vivid Color

= Enable Simulate Display

= Enable Commercial Press
= Enable Euroscale Press

= Enable SWOP Press

= Enable Monochrome

= Enable Raw RGB Colors
= Enable Raw CMYK Colors
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Download PostScript files

Use the Send PostScript File command in the Printing menu to download
PostScript files to the selected desktop printer. This command cannot be
used on a shared printer, except by the Macintosh hosting the shared printer;
the command is not visible in the menu.
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1. Select (highlight) a desktop printer icon.
2. Select Send PostScript File from the Printing menu.
3. Select the PostScript file you want to download.

4. Click Open to send the file to the printer.
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About shared printers

You can share a desktop printer in the same way you share files,
folders, or volumes, with the Sharing command on the File menu.
Both the host and client computers must have a copy of the same
printer driver.

Setting up a shared printer
1. Create a desktop printer according to the instructions on page 8-3.

2. Highlight the desktop printer icon you want to share.

gfad)

FPhazer 240

3. Select Sharing from the File menu.

4. Click the check box to turn on Share this printer.
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5. Click the close box.
6. Atthe alert message, click Save.

7. The desktop printer’s icon changes to reflect the change in status
to a shared printer.

Fhazer 240

8-14 Phaser 540 Drivers and Utilities



Using the Phaser 540 GX Driver 8

Using a shared printer

If you want to use a printer hosted by another user’s computer, do
the following:

1. Open the Chooser from the Apple menu.

2. Click the Phaser 540 GX printer driver icon on the left side of the
Chooser.

3. Inthe Connect via field’s pop-up menu, select Servers.

4. The list of printers in the Chooser changes to show only shared
printers. Click on the shared printer you want to use.

5. Close the Chooser.
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Printing from QuickDraw GX-aware applications

If you are using QuickDraw GX applications with the Phaser 540 GX driver,

the Page Setup

LaserWriter 7.1.

and Print dialog boxes look different from the standard
2 dialog boxes described in Chapter 2.

Using the Page Setup command

When you select Page Setup from the File menu, the following dialog box

appears:
Fage Selup
Pepee type: igitee ¥ 0"
Orieniaiion: . I-'E I@
Srale; m %
| b Cvmicas Candal |

When you click the More Choices button, the dialog box expands to show
the following options:

Fane wles
Paper Type; | Lel e :. 141
l Sreealatisac .l || |
scete- ) %
Fgomsal Tz | Phaser 580 62 -]
[ Femrer Cnabtns | [Camol |
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Page Setup options

Row of icons

The scrollable icon list on the left side of the dialog box represents
printing extensions that are available to the printer driver. When
selected, the General icon displays the normal Page Setup
options. Select another icon to see a new dialog of options.

Refer to Apple’s QuickDraw GX documentation for instructions
on installing printing extensions; refer to page 8-20 to use the
Extensions Setup command in the Printing menu to enable
installed printing extensions.

Paper Type
This is a list of page sizes available for the selected printer. Refer
to page 5-2 for page size details.

Orientation
This is a standard driver option. Refer to page 5-12 for image
orientation details.

Scale
This is a standard driver option.

Format for

This pop-up menu allows you to select a different desktop printer
for formatting your document.

Printing Reference
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Using the Print command

When you select Print from the File menu, the following dialog box appears:

Print
Print to: [ Phaser 540 v| 1ot
Pages: @ All
C)From:| | To;l |
Copies: E

When you click the More Choices button, the dialog box expands to show
the following options:
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Print dialog box options

Row of icons

The scrollable icon list on the left side of the dialog box list
represents printing extensions that are available to the printer
driver. When selected, the General icon displays the normal Print
options. Select another icon to see a new set of options. Print
Time and Paper Match are part of the QuickDraw GX software
and are always available.

The rest of the options in this dialog box are standard driver
options described in Apple documentation.

Paper Feed: Automatic or Manual

When printing on manually-fed media, you need to select Manual
in this dialog box, and select the appropriate Manual Feed Media
option in the TekColor printing extension described on page 8-20.

Printing Reference
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8-20

Using the TekColor printing extension

Select the TekColor icon at left of the dialog box to see printer options:

Pl
- Bl PRaser 40 Oplions: Tekironix
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. i Color Correctiss: [ Wone |
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Note  This dialog box is similar to the one that appears when you select
Printer Driver Defaults from the Printing menu; refer to
page 8-10 for details.

The default settings in this dialog box reflect the defaults for the selected
desktop printer. With most applications, you can change the printing
options and save those options with each document.

Using the Paper Match printing extension

This dialog box lets you specify paper trays. A paper tray selection in the
Paper Match printing extension overrides the tray selection choice in the
TekColor printing extension. You should use the TekColor printing
extension for selecting all printing options.

Phaser 540 Drivers and Utilities



Using the Phaser 540 GX Driver 8

Printing from non-QuickDraw GX-aware applications

If you are using non-QuickDraw GX applications with the Phaser 540 GX
driver, the Page Setup and Print dialog boxes look similar to the standard
LaserWriter 7.1.2 dialog boxes described in Chapter 2. However, unlike the
dialog boxes described in Chapter 2, these dialog boxes have no
printer-specific options, such as TekColor color corrections. These dialogs
reflect the selections made in the default desktop printer. You cannot change
these printer settings from the application, but you can change them by
selecting (highlighting) the default desktop printer and using the Printer
Driver Defaults command in the Printing menu. You can also change the
default desktop printer before you change printing selections.

Changing a desktop printer’s default selections
1. Click to highlight the default desktop printer.

[ep]

Phazer 240

2. From the Printing menu, select Printer Driver Defaults.
The following dialog box appears:
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3. Make the desired printer selections, then click OK.

4. Return to your application.
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Changing the default desktop printer
1. Highlight the desktop printer that you want to set as the default.
2. From the Printing menu, select Set Default Printer.

A check-mark appears next to the command, and a bold outline
appears around the desktop printer icon.

Disabling QuickDraw GX

8-22

You may want to disable QuickDraw GX when printing from some
non-QuickDraw GX applications so you can use the Phaser 540 printer
driver (based on the LaserWriter 7.1.2 driver) described in Chapter 2.

1. Open the Extensions folder inside the System Folder.

2. Drag the QuickDraw™ GX extension onto the desktop.

3. Select Restart from the Special menu.
Any desktop printers created before you disabled QuickDraw GX will have

an “X” drawn through the icons. These desktop printers remain unavailable
for use until QuickDraw GX is re-enabled.
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Viewing printer status
Once you send a print to a desktop printer, you can monitor the status of the

print job in the Printer Status dialog box. There are two ways to open the
Printer Status dialog box:

= Select (highlight) the appropriate desktop printer icon, then select
Open from the File menu.

= Double-click the appropriate desktop printer icon.
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Chapter

Troubleshooting

Getting help

Using the Tektronix Bulletin Board Service

The Tektronix Bulletin Board Service (BBS) is available for direct
downloading of the latest versions of printer drivers, utilities, and files. If
you have a Macintosh or PC, communication software, and modem, you can
call the service and use the menus to locate and download the files

you want.

To access the BBS 24 hours a day, seven days a week, call (503) 685-4504.

For a detailed instruction guide on system requirements, terminal settings,
protocol, modem, how to connect to our BBS, and how to download files,
request a document catalog from HAL or EuroHAL, the Tektronix
automated fax systems. See page 9-2 for instructions on using these systems.

Reaching the Technical Support staff

If your problem is still not resolved after trying the suggestions in this
chapter, call the Tektronix Technical Support Hotline in the United States
from 6 AM to 5 PM PST, Monday through Friday, at 1-800-835-6100.
Outside the U.S., contact your reseller or local Tektronix office.

Also, refer to the HAL catalog for articles on using the printer, specific

applications, and computing environments; see page 9-2 for instructions on
using HAL and EuroHAL.
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Using the automated fax systems

As an alternative to using the Customer Support Hotline, and to provide
up-to-date information quickly, Tektronix has set up HAL (Highly
Automated Library) and EuroHAL, two interactive, automated fax systems.
These automated fax systems provide Macintosh, PC, and workstation users
with the latest technical hints and tips (like color matching), solutions to
common technical problems, and application notes (like CoreDRAW! and
QuarkXPress).

You may call HAL or EuroHAL from anywhere in the world. The fax
systems are available 24 hours a day, seven days a week.

Use HAL to order a catalog or individual documents
in the U.S.A. and Canada

If you have a fax machine and a touch-tone voice telephone, you can order a
HAL catalog listing all the information offered by HAL.

Call (503) 682-7450 (direct) or, in the U.S. and Canada, call 1-800-835-6100
(at the prompt, choose the option for technical documentation via fax).

Note  Before ordering documents from HAL, order a catalog listing the
numbers of available documents. You may want to replace your
catalog periodically, since the system is often updated.

1. Before you call, write down the area code and telephone number
for your fax machine. HAL will ask you to key this number using
the keypad on your voice telephone.

If you are calling from outside the United States or Canada, you’ll
need to know the international access code to reach your country
from the United States. Without a complete fax number, HAL
cannot call your fax machine.
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2. Call only from a touch-tone voice telephone.
3. Follow the voice-prompted (English) menu.

4. Order individual documents by entering the desired document’s
number as listed in the HAL catalog. Use your telephone’s keypad
to enter the number.

5. You can order up to three documents per call.

6. The HAL catalog or documents that you request are faxed to you
in a matter of minutes.

Use EuroHAL to order a catalog or individual documents in Europe

EuroHAL includes many documents, some in English and some in other
European languages. If a local version of the document you want is
available, EuroHAL will send it in your language. Otherwise, it will send
English documents.

If you have a tone-dial telephone and a fax machine, then you can use
EuroHAL. If your telephone has star (*) and hash mark (#) keys, then it can
probably use tones; ask your local telephone supplier if you are not sure.

If your telephone does not have these keys or has a dial, you will need to buy
a tone dialer from your local telephone or electronics shop. This small box is
held to the phone and sends the standard tones that you need to talk to
EuroHAL.
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1. To use EuroHAL, dial one of the numbers listed in the
following table.

Country Number

Austria 00 44 1628 478 347
Belgium 00 44 1628 478 347
Denmark 00 44 1628 478 347
Finland 990 44 1628 478 347
France 0590 81 86
Germany 0130 819 220
Holland 00 44 1628 478 347
Italy 00 44 1628 478 347
Norway 095 44 1628 478 347
Spain 07 44 1628 478 347
Sweden 009 44 1628 478 347
Switzerland 00 44 1628 478 347
UK 01628 478 347

Other countries +44 1628 478 347 (where + is your country’s

International Access Code)

2. EuroHAL answers and asks which language you want to use.

For English Press 1
For French Press 2
For German Press 3

3. The first time you use EuroHAL, you should order a catalog. This
lists all the documents that are available, and is constantly
updated.
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EuroHAL asks you for your fax machine number. If you are
calling from outside the UK, add your country code first, as

shown in the following table.

9

Press #
Your area code and when

Country Country code fax number finished
Austria 00 43 area code fax number #
Belgium 00 32 area code fax number #
Denmark 00 45 area code fax number #
Finland 00 358 area code fax number #
France 00 33 area code fax number #
Germany 00 49 area code fax number #
Holland 0031 area code fax number #
Italy 00 39 area code fax number #
Norway 00 47 area code fax number #
Spain 00 34 area code fax number #
Sweden 00 46 area code fax number #
Switzerland 00 41 area code fax number #
UK just enter your fax number  #
Other countries 00 xx area code number #
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Using the Internet to download Tektronix files

If you don’t have a way to transfer files from the Tektronix Windows 3.1
Driver and Printer Utilities diskette, you can request files from the Tektronix
Color Printer Information Server, an automatic file serving program that
responds to requests for files.

If you can exchange electronic mail with other Internet sites, you can access
the Tektronix Color Printer Information Server. From this server you can
retrieve driver and utility files and color printer information.

For the mail requests listed in the following table, substitute the library of
your choice for library-name  , and the file of your choice for filename

Send your requests for files to the following electronic mail address:

color_printer_info @ TEKTRONIX.TEK.COM

Electronic mail requests

To Type this command

Receive the list of send index

information available on . .

the server (type this at the Subject prompt)

Examine the full index for send index from library-name
any library

Request a file from a library send filenamigom library-name

Determine a file's size send list of filenamigom library-name
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Solving PostScript printing problems

PostScript printing errors

If you get a PostScript error when printing from Aldus PageMaker, Aldus
FreeHand, QuarkXPress, or Canvas, you may be using an older or incorrect
version of the printer description file. Refer to “Printing from an
application” on page 2-16 (Macintosh) or page 3-26 (PC) for instructions on
using printer description files.

When using printer description files, it is important to match the
application’s version number to the printer’s firmware version number. You
can check the printer’s firmware version number by printing a copy of the
printer’s startup page. Refer to the Phaser 540 Color Printer User Manual for
instructions on using the front panel to print the startup page. If you have
upgraded your printer’s firmware version, you may need a newer printer
description file.

For the most current printer description files, check the Tektronix Bulletin
Board Service (BBS). Refer to page 9-1 for instructions on using the
Tektronix BBS.

The following table lists a few Macintosh applications and some possible
PostScript errors. For information on PC and other applications, request a
document catalog from HAL or EuroHAL. Refer to page 9-2 for instructions
on using these systems.

Application

Error or problem Solution

QuarkXPress 3.11
QuarkXPress 3.2

Offending Command: cbind You are probably using an older PDF file. Check the

BBS for the most current version of this file.

QuarkXPress 3.1x

Graduated fills print in black-and-white  You are probably using an older PDF file. Check the

BBS for the most current version of this file.

FreeHand 3.1

error:typecheck A PostScript fill is being used with a color correction
offending command: put from the printer driver. Turn off any color correction

in the driver and the image should print correctly.

FreeHand 3.1

TIFFs print in black-and-white You are probably using the wrong PDX file. Check

the BBS for the most current version of this file.
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Random PostScript errors

If you are using AppleTalk Network Software below version 58.0, you may
experience a problem with random PostScript errors when printing. If this is
the case, you should upgrade the AppleTalk Network Software on your
Macintosh computer.

The printing problem is due to a timing conflict between the older AppleTalk
software and the printer. The PostScript errors can be any type of error or
offending command, and may occur in any of the following situations:

= May occur more often over LocalTalk than EtherTalk.

= Sending the same file more than once may cause different errors or
offending commands each time, or the file may print without
an error.

= Files from some applications may print, while files from other
applications may not.

= Documents saved to PostScript files and sent to the printer with a
downloading utility may generate errors.

To upgrade your software

1. Insert the AppleTalk Installer for the Macintosh diskette into your
computer’s disk drive. This diskette was shipped with your
printer.

2. Double-click on the Installer icon.

3. Click OK in the introduction screen.

4. Click Install in the Easy Install window to install the
recommended software. (Or, click Customize to select
individual items.)

5. After successful installation, click Restart to restart
your computer.
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Using a PostScript error handler

The error handling utility is useful for diagnosing problems when a job
doesn’t print. This utility installs a PostScript error-handling function in the
printer to help determine the cause of some PostScript printing problems.
PostScript errors are printed on a page with other status information when
an error occurs. This utility can also be used by programmers for debugging
PostScript code.

To turn on the error handler, refer to the following instructions. To turn off
the error handler, follow the instructions on page 9-23 to reset the printer.

Macintosh users

1.

If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

Double-click on the LaserWriter Utility icon.
Select Download PostScript File from the Utilities menu.

Select the Tek Error Handler file in the folder on your hard disk
containing decompressed utility files and click Open.

At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Then click Save
to send the file to the printer.

If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the dialog box.
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PC and workstation users

1. Locate the TEKEHAND.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

2. Copy the file to your hard disk, or use it from the diskette.
3. Use one of the following methods to send the file to the printer:

= PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 20
and page 21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Improving print speed

Note

There are different ways to improve print speed, such as by
upgrading to EtherTalk on a Macintosh, to Novell NetWare on a
PC, or to TCP/IP on a workstation. For more information,
request a document catalog from HAL or EuroHAL, the Tektronix
automated fax systems. Refer to page 9-2 for instructions on
using these systems.

If you tried to print a document with bitmapped images to a PostScript
Level 2 printer, but are dissatisfied with the speed of the output, here are
some suggestions.

All users

When you use any color correction option (other than None), your
printer can take longer to process bitmapped images.

The Fast print quality option prints faster than the Standard or
Enhanced options. Select print quality modes from the Tektronix
drivers, with downloadable utility files, and from the printer’s
front panel.

Windows users

1.

5.

Turn off the Print Manager; printing via the Print Manager is
slower, but turning it off ties up the PC longer.

Select the Tektronix Phaser 540 printer in the Printers dialog box.

Verify that the Use PostScript Level 2 Features check box in the
Advanced Options dialog box is turned on.

From your application, choose the Tektronix Phaser 540 as your
printer.

Try printing the document again.

Workstation users

Use the Tektronix Phaser Print software for faster printing.
See page 4-2 for details.

Printing Reference 9-11



9 Troubleshooting

If your file doesn't print

If you’ve configured the Tektronix driver for your printer but your printer
isn’t printing, try the following suggestions. If these suggestions fail to solve
the problem, copy the Tektronix PostScript Level 2 error handler utility to
your printer to determine what is wrong. Refer to page 9-9 for information

on using the error handler.

General things to check for

Macintosh users

Open the Chooser and select the Tektronix Phaser 540 driver and
the printer you want to use.

If you are having trouble printing from the Finder in System 7.1
(for example, if the Phaser 540 driver dialog boxes are not
opening), it may be because the Finder doesn’t have enough
allocated memory. Reinstall the Tektronix driver to automatically
allocate enough memory for printing from the Finder.

Windows users

Make sure that your printer is connected to the port you selected
in the Printers/Connect dialog box.

Make sure you’ve configured the communications ports and the
Handshake option correctly. To check the configuration, print a
configuration page; see page A-4 for instructions.

Try resetting the Transmission Retry timeout option in the
Printers/Connect dialog box to 850 seconds.

Check the Options dialog box to make sure that Printer, not
Encapsulated PostScript File, is selected in the Print To box.

The following error message appears on your computer screen:
Windows Header has not been downloaded to the printer.

Open the Options dialog box and turn on the Send Header with
Each Job check box. Refer to page 3-10 for details.
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If you are using PC/NFS

If you have PC/NFS software installed on your computer, you need to make
the following selection in the Network Options dialog box:

1. Double-click the Print Manager icon from the Main window.

2. Select Network Settings from the Options menu in the Print
Manager.

3. Uncheck the Print Net Jobs Direct box in the Network Options
dialog box.

4. Click OK.

If you can’t print from Windows to an LPT port

If your printer is connected through an LPT (parallel) port and your
document doesn’t print, try the following:

1. Double-click the Printers icon in the Control Panel.

2. Inthe Printers dialog box, choose your printer from the list of
installed printers.

3. Click the Connect button to open the Connect dialog box.

4. Change your port connection from LPTx to LPTx.DOS
(where xis 1, 2, or 3).

5. Click OK.
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Check the printer's language mode

If your file doesn’t print, the language on the printer’s port you are using
may have been changed.

1. Printacopy of the printer’s configuration page to see the language
mode on each port. Refer to page A-4 for instructions on printing
a configuration page.

2. Ifthe printer port you are using has the wrong language set for the
type of application you are using, send one of the following utility
files to the printer:

= To print PostScript files, use the PSCRIPT.PS file to set up a port to
receive PostScript; see page C-5 for details.

= To print HP-GL files, use the HPGL.PS file to set up a port to receive
HP-GL,; see page C-5 for details.

= To print PostScript, or HP-GL, or PCLS5 files, use the AlS.PS file to

set up a port for automatic language selection; see page C-5
for details.
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Fixing timeout problems in Windows

Try one of the following procedures to correct Windows timeout problems.
If the Windows procedure doesn’t work for you, try the DOS procedure.

From Windows
1. Select Control Panel from the Main menu.
2. Select Printers.
3. Click the Connect button.
4. Increase the Transmission Retry to 850 seconds.
From DOS
Note  To use this procedure, the printer must be connected directly to
your computer, not on a network.
1. Atthe DOS prompt, run the DOS MODE command by typing the
following:
MODE LPT1:,,P
2. Start Windows.
3. Select Control Panel from the Main menu.
4. Select Printers.
5. Click the Connect button.
6. Change the port selection from LPT1 to either LPT1.DOS or

LPT1.0S2, depending on the options you see in the dialog box.
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Correcting printing problems

Printed colors are not what you expected

Select another Color Correction option in the driver and print
your image again. Refer to Chapter 6, “Using Color,” for more
information.

If you are not using a Tektronix driver and are sharing the printer
with other users on a network, another user may have changed
the printer’s color adjustment setting. Refer to page 9-20 for more
information.

If you use the driver’s Use Printer Setting option and printed
colors are not what you expected, check the selection in the
TekColor Corrections menu on the printer’s front panel. These
settings change the printer’s default color correction. Refer to
page 6-6 for details on how these settings affect prints made from
the driver.

If PANTONE Colors are not printing as expected, make sure you
are printing without any color corrections as outlined below.
Also, refer to page 6-17 for information on printing the PANTONE
Color chart.

If you have questions about PANTONE Color matching, refer to
the HAL article on PANTONE Colors. Refer to page 9-2 for
instructions on using HAL and EuroHAL.

= From the Tektronix Macintosh driver, select the None option in the

TekColor Options dialog box.

= From the Tektronix Windows driver, select the None option in the

Tektronix Printer Features dialog box.

= Ifyou are not using a Tektronix driver, select None in the TekColor

Correction menu on the printer’s front panel, or download the
No Color Correction (NOCORECT.PS) utility file to the printer.
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Use Tektronix halftone screens

Tektronix halftone screens are designed for Tektronix printers, and improve
print quality over application-set halftone screens. The Setscreen Patch utility
file redefines the setscreen, setcolorscreen, and sethalftone PostScript operators.
When downloaded to the printer, this file prevents applications from
overriding the Tektronix proprietary halftone screens.

Macintosh file name PC file name

Setscreen Patch SETSCRN.PS

Macintosh users

1.

If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

Double-click on the LaserWriter Utility icon.
Select Download PostScript File from the Utilities menu.

Select the Setscreen Patch file in the folder on your hard disk
containing decompressed utility files and click Open.

At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Then click Save
to send the file to the printer.

If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the dialog box.
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PC and workstation users
Use one of the following methods to send the file to the printer:
s PCusers: Usethe DOS COPY command or the Copy command in

Windows File Manager to send the file to the printer. See page 20
and page 21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.

Blue colors look too purple

9-18

Use one of the following methods to print with the Vivid Color
color correction.

= Phaser 540 Macintosh driver (LaserWriter 7.1.2-based)
Select the Vivid Color option in the TekColor Options dialog box.

= Phaser 540 GX driver
Select the Vivid Color option in the Printer Driver Defaults
dialog box.

= Windows driver
Select the Vivid Color option in the Tektronix Printer Features
dialog box.

= Printer’s front panel
TekColor Corrections menu, Vivid Color option.
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Selecting page sizes in Windows applications

In some Windows applications, you can select printer page sizes in a Print
Setup dialog box accessed from the File menu. If you use a Print Setup
dialog box to select the Phaser 540 from your application, some page sizes
may not appear in the list.

If the Phaser 540 page size you want to use does not appear in the list:

1.

6.

From the Main window, open the Control Panel and double-click
the Printers icon.

In the Printers dialog box, select the Phaser 540 in the list of
printers.

Click the Setup button.

In the Setup dialog box, select the page size you want and
click OK.

Return to your application. If you open the Print Setup dialog
box again from within your application, the page size selection
may be blank. The page size you just selected in the driver is still
selected, it is just not visible in the list.

Print as usual.

If you open the Print Setup dialog box from within an application, and

the page size selection is blank, the blank represents the page size last
selected from the printer driver through the Control Panel. You can leave
the page size selection blank and print as usual, or you can select a page size
from the list.
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Sharing the printer on a network

Driver, utility file, and front panel interactions

If your Phaser 540 printer is shared by other users on a network, using the

9-20

downloadable utility files or the printer’s front panel to change the printer’s

default color correction setting can affect prints made by other users.

When you print from a Tektronix driver with any TekColor color
correction option except Use Printer Setting, the driver selection
overrides the following selections for prints made from the driver:

A color correction utility file, if one has been downloaded to the
printer.

The selection on the printer’s front panel TekColor Corrections
menu.

When you print from a Tektronix driver using the Use Printer
Setting option, your images are printed with one of the following
selections:

A color correction utility file, if one has been downloaded to the
printer.

The selection on the printer’s front panel TekColor Corrections
menu.

When you print from a non-Tektronix driver, your images are
printed with one of the following selections:

A color correction utility file, if one has been downloaded to the
printer.

The selection on the printer’s front panel TekColor Corrections
menu.

If the colors on your prints are not what you expected, and your
system administrator has disabled some of the printer’s front
panel menus, ask them what settings are in effect and whether a
color correction utility file has been downloaded to the printer.
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LaserWriter Utility does not work

The LaserWriter Utility cannot be used if the printer is connected to a print
server. See your system administrator to temporarily remove the printer
from the print server to download any of the PostScript utility files.

Programs crashing on a network (Macintosh)

On Macintosh computers with a 68040 microprocessor (Quadra, Centris, and
Performa 470 series), some programs may quit unexpectedly, or freeze the
computer, when you try to open them over a network. To fix this problem,
install the Network Launch Fix from the AppleTalk Installer for the Macintosh
diskette shipped with your printer.

1. Insert the AppleTalk Installer for the Macintosh diskette into your
computer’s disk drive.

2. Drag the Network Launch Fix icon from the diskette to the
Extensions folder, inside the System Folder on your computer’s
hard disk.

3. Restart your computer.
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Resetting the printer

The Reset Printer (RESET.PS) file resets the printer to its power-on conditions
(not its factory default conditions), without turning the printer’s power
switch off and on. The power-on conditions include any custom changes
made to the printer that are stored in the printer’s NVRAM, or changes that
are persistent across printer power cycles. For example, if you used
downloadable utility files to change the printer’s name or set a color
correction, these are power-on conditions that are not altered by resetting the
printer. Resetting the printer erases changes that are not persistent across
printer power cycles, such as the Tektronix error handler utility.

This file restarts the printer as soon as all the jobs in its queue are finished.
The printer remains unavailable while it initializes.

Macintosh file name PC file name
Reset Printer and RESET.PS
LaserWriter Utility

Macintosh users

Note Do not use the Restart Printer command in the LaserWriter
Utility’s Utilities menu. Follow this procedure to reset
the printer using the LaserWriter Utility to download the
Reset Printer utility file.

1. If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

2. Select the appropriate printer in the Chooser.

3. Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.
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4. Double-click on the LaserWriter Utility icon.
5. Choose Download PostScript File from the Utilities menu.

6. Select the Reset Printer file in the folder on your hard disk
containing decompressed utility files and click Open.

Note  The process of resetting the printer takes a few minutes to
complete. You will receive a message on your screen
indicating the connection has been interrupted during the reset.
The connection is re-established after the reset, so you can ignore
this message; click the Continue button.

7. At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Click Save to
send the file to the printer.

8. If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the dialog box.

PC and workstation users

1. Locate the RESET.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

2. Copy the file to your hard disk, or use the file from the diskette.

3. Use one of the following methods to send the file to the printer:

9

= PCusers: Use the DOS COPY command or the Copy command in

Windows File Manager to send the file to the printer. See page 20

and page 21 for details.

= Workstation users: Send the file to the printer as you would any

PostScript file.
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Can't open the READ ME files on the Macintosh diskettes

The Tektronix Macintosh Driver and Printer Utilities diskette contains a
READ ME file providing information that arrived too late to be included in
this manual. The READ ME file was written in the TeachText program. You
must have a copy of TeachText (or SimpleText for system 7.1 and later)
installed on your hard disk to read these files. If you don’t have a copy
already installed, copy TeachText or SimpleText from the same Apple system
software diskettes that you last used to upgrade your computer.

If you have problems using the media trays

The printer comes standard with one paper tray. You can add an optional
Lower Tray Assembly, which holds two additional media trays. Refer to the
Phaser 540 Color Printer User Manual for more information on optional
printer accessories.

If you have problems with the media trays, you may find it helpful to
understand how tray switching works. The following list outlines tray
behavior and makes suggestions for you to try. When your printer is
equipped with only one tray, the printer automatically picks media from
that tray.

= Make sure your driver media selection matches your tray
selection. For example, if you select A4-size paper, you must also
select the location (upper, middle, or lower) of the A4 Paper tray.

= If you have selected the upper, middle, or lower tray from the
driver and the job doesn’t print, make sure the selected tray
contains media.

= If you choose the Paper or Transparency selections using the
driver or the printer’s front panel, the printer picks media from a
media tray of the appropriate type until that tray is empty. When
that tray is empty, the printer switches to another tray, as long as a
tray of the appropriate type is available (paper or transparency).
Otherwise, printing stops until you fill the tray.
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s For those not using a Tektronix driver
If you send the Use Any Tray (ANYTRAY.PS) file to the printer,
when one tray runs out of media, the printer automatically
switches to one of the other trays only if it contains the same media
type as the first tray. If there are two different media types in the
trays, the printer does not automatically switch trays.

Refer to the Phaser 540 Color Printer User Manual for more information.
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Appendix

A Modifying Printer
Operations

This appendix explains how to modify printer operation by:

Enabling and disabling the startup page

Printing a configuration page

Changing the EtherTalk zone

Enabling and disabling the menus on the printer’s front panel
Configuring a printer’s serial port for a PC

Enabling and disabling bi-directional status reporting
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Enabling and disabling the startup page

Note If you are using a Macintosh with System 7.5 and QuickDraw
GX, you can use the Tektronix Phaser 540 GX driver to print a
copy of the startup page without turning the printer off and on.
Refer to page 8-11 for instructions.

You can also print a copy of the startup page from the printer’s

front panel; refer to the Phaser 540 Color Printer User Manual
for instructions.

You can choose to have a startup page print each time the printer is turned
on or reset, or you can disable the startup page.

Use one of the following files depending on your computer type.

Macintosh file name PC file name
LaserWriter Utility NOSTRTPG.PS
STARTPG.PS

Macintosh users

1. If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

2. Select the appropriate printer in the Chooser.

3. Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

4. Double-click the LaserWriter Utility icon to start the application.
5. Choose Set Startup Page from the Utilities menu.

6. Select either the on or off button, then click OK.

A-2 Phaser 540 Drivers and Utilities



Modifying Printer Operations A

PC and workstation users

s Use the STARTPG.PS file to enable printing of the printer’s
startup page.

= Use the NOSTRTGP.PS file to stop the printer from printing a
startup page.

1. Locate the startup page files in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

2. Copy the files to your hard disk, or use the files from the diskette.

3. Use one of the following methods to send the desired file to the
printer:

= PCusers: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.

Printing Reference A-3



A Modifying Printer Operations

Printing a configuration page

A configuration page is similar to the printer’s startup page, but it also
provides details about each available port. Use one of the following files
depending on your computer type.

Macintosh file name PC file name
Configuration Page PRNTCNFG.PS

Macintosh users

1. If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

2. Select the appropriate printer in the Chooser.

3. Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

4. Double-click the LaserWriter Utility icon to start the application.

5. Choose Download PostScript File from the Utilities menu.

6. Select the Configuration Page file from the list and click Open.

7. At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Click Save to

send the file to the printer.

8. If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the dialog box.

A-4 Phaser 540 Drivers and Utilities



Modifying Printer Operations A

PC and workstation users

1. Locate the PRNTCNFG.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

2. Copy the file to your hard disk, or use the file from the diskette.
3. Use one of the following methods to send the file to the printer:
= PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation user: Send the file to the printer as you would any
PostScript file.
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Setting the printer's EtherTalk zone

A-6

A zone is a logical grouping of network devices, such as an engineering or
marketing zone. Ask your network administrator which zone your printer
should be in.

A network needs to be able to uniquely identify any device, so you must
make sure the zone on EtherTalk is different from the zone on LocalTalk. If
you make the EtherTalk zone the same as the LocalTalk zone, the printer
automatically makes the name seen on the LocalTalk network different from
the name seen on the EtherTalk network. For example, it would change the
default printer name Phaser 540 to Phaser 540 (via LocalTalk). This
automatic renaming keeps the printer operational regardless of zone or
name conflicts and lets you distinguish the high-speed Ethernet connection
from the slower LocalTalk connection.

Use one of the following files depending on your computer type.

Macintosh file name PC file name

Set EtherTalk Zone ETHRZONE.PS

Macintosh users

With devices grouped into zones, you can use the Chooser to see all the
printers in any zone.

To designate the EtherTalk zone, use the Set EtherTalk Zone utility file. You
will have to edit this file. You must have a copy of TeachText (or SimpleText
for System 7.1 and higher) installed on your hard disk to do this editing. If
you don’t have a copy already installed, copy TeachText (or SimpleText) from
the same Apple system software diskettes you last used to upgrade your
computer.

If you have both LocalTalk and Ethernet cables as part of the same Apple
Internet, it is recommended that you connect only the Ethernet cable. There
is no benefit to making both LocalTalk and Ethernet connections to the
printer if both cables are part of the same Apple Internet. See the Phaser 540
Color Printer User Manual for information on printer behavior in this
configuration.
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If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

View the file in TeachText or SimpleText.

Replace the name within the parentheses (My Zone Name) with the
name of the EtherTalk zone your printer is in.

Save the file and quit.
Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

Double-click the LaserWriter Utility icon to start the application.
Choose Download PostScript File from the Utilities menu.
Select the Set EtherTalk Zone file from the list, then click Open.

At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Click Save to

send the file to the printer.

If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the box to continue.
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A-8

PC and workstation users

To designate the zone on EtherTalk, use the ETHRZONE.PS file. You must

edit this file.

1. Ask your network administrator which zone you should use.

2. Locate the ETHRZONE.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

3. Copy the file to your hard disk.

4. View the file and replace the name within the parentheses (My
Zone Name) with the name of the EtherTalk zone that your
printerisin.

5. Save the file and quit.

6. Use one of the following methods to send the file to the printer:

= PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Enabling and disabling front panel menus

You can enable and disable the printing features menus on the printer’s front
panel. For example, selections made on the printer’s front panel can affect
the prints of all users sharing the printer on a network. A system
administrator may want to disable the menus so users can only select
printing features, such as color corrections, through their applications on an
individual basis.

Macintosh file name PC file name
Menu Short MENUSHRT.PS
Menu Long MENULONG.PS

Note  Ifyou have used the Menu Short (MENUSHRT.PS) file to disable
the front panel menus, you can temporarily re-enable the menus
by holding down the Menu button while pressing the Exit
button. You can scroll through the menus as usual, however,
when you press the Exit button again the front panel returns to
the shortened form.

Macintosh users

= Use the Menu Short file to disable the printing features menus on
the printer’s front panel.

= Use the Menu Long file to expand the printer’s front panel to show
all menus.

1. If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

2. Select the appropriate printer in the Chooser.

3. Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

4. Double-click the LaserWriter Utility icon to start the application.
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A-10

5.

Choose Download PostScript File from the Utilities menu.

Select the Menu Short file or the Menu Long file from the list and
click Open.

At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Click Save to
send the file to the printer.

If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the box to continue.

PC and workstation users

Use the MENUSHRT.PS file to disable the printing features menus
on the printer’s front panel.

Use the MENULONG.PS file to expand the printer’s front panel to
show all menus.

Locate the MENUSHRT.PS file and the MENULONG.PS file in the
PHSR540 directory on the Tektronix Windows 3.1 Driver and
Printer Utilities diskette.

Copy the files to your hard disk, or use the files from the diskette.

Use one of the following methods to send the desired file to the
printer:

= PCusers: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Configuring a printer’s serial port for a PC

If your printer has the optional serial port installed, you can configure the
port using the DEVPARAM.PS file or using front panel selections. Refer to
your Phaser 540 Color Printer User Manual for information on configuring
serial ports from the front panel.

Note  To modify DEVPARAM.PS you should be familiar with the

PostScript setdevparams command. You should also know how
to use PostScript dictionaries and key value pairs.

You should edit the DEVPARAM.PS file before using other files to change
the printer’s performance.

The following example sets these parameters:
= Flow control to Xon/Xoff

= Parity to none

= Databitsto 8

= Stop bitsto 2

= Baud rate to 9600

In this example, the changes are persistent across jobs and across printer
power cycles; they remain in effect until you change them again.

(%Serial_NV%) 6 dict begin

/Password () def
/FlowControl /XonXoff def
[Parity /None def
/DataBits 8 def
/StopBits 2 def

/Baud 9600 def

currentdict end setdevparams

Printing Reference A-11



A Modifying Printer Operations

1. Locate the DEVPARAM.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

2. Copy the file to your hard disk.
3. View the file and substitute the values you want to use for the
current values in DEVPARAM.PS. The possible values for each
parameter are listed in the table on the next page. The values are
case-sensitive and must be entered exactly as shown in the table.
4. Save the file.
5. Configure the printer port to receive PostScript.
6. Use one of the following methods to send the file to the printer:
= PCusers: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.

A-12 Phaser 540 Drivers and Utilities



Parameter values

Modifying Printer Operations

Parameter key

Allowed values

Type

FlowControl

XonXoff (software)

Dtr (hardware)

string

Parity

Even
Odd
None
Space

string

DataBits

7
8

integer

StopBits

1
2

integer

Baud

300
600
1200
2400
4800
9600
19200
38400

integer

Enabled

true
false

boolean

CheckParity

true
false

boolean

On

true
false

boolean

Interpreter

PostScript
HP7475A

string

Protocol

Normal
Raw
Binary

string
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Enabling and disabling bi-directional status reporting

These utility files are provided for support of future operating systems and
applications that are capable of bi-directional status reporting with a printer
connected to the parallel port. This feature uses the IEEE specification, and
supports the Nibble Mode protocol.

You do not need a special cable; refer to the Phaser 540 Color Printer User

Manual for information on ordering the standard parallel cable available
from Tektronix.

Note  Windows 3.0 and 3.1 do not support bi-directional status
reporting.

The printer is shipped with the uni-directional mode enabled.

= Use the BIDIR.PS file to enable bi-directional status reporting on a
parallel port.

= Use the UNIDIR.PS file to disable bi-directional status reporting.

1. Locate the BIDIR.PS file and the UNIDIR.PS file in the PHSR540
directory on the Tektronix Windows 3.1 Driver and Printer
Utilities diskette.

2. Copy the files to your hard disk, or use the files from the diskette.

3. Use one of the following methods to send the desired file to the
printer:

= PC users: Use the DOS COPY command, or the Copy command in
the Windows File Manager, to send the file to the printer. See page
3-20 for instructions.

= Workstation users: Send the file to the printer as you would any
PostScript file.

A-14 Phaser 540 Drivers and Utilities



Appendix

Using SCSI Hard Disks

This appendix explains how to use a SCSI hard disk with your Phaser 540
printer. It covers the following topics:

= Selecting a SCSI hard disk
= Formatting a SCSI hard disk
= Initializing a formatted SCSI hard disk

= Enabling and disabling SysStart job execution

Selecting a SCSI hard disk

The printer can use most SCSI hard disks that support the full SCSI
command set. Also, most SCSI hard disks that work with an Apple
LaserWriter will work with a Phaser 540 printer. Contact your computer or
printer dealer for information.

For additional information on SCSI hard disks, request a document catalog

from HAL or EuroHAL, the Tektronix automated fax systems. Refer to page
9-2 for instructions on using these systems.
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B Using SCSI Hard Disks

Formatting a SCSI hard disk

B-2

Caution  This procedure erases all data from all SCSI hard disks
connected to the printer. Disconnect from the printer any hard
disk you do not want reformatted, for example, a disk
containing fonts.

Use this procedure to format a SCSI hard disk connected to the printer, then
follow the instructions in “Initializing a formatted SCSI hard disk on page
B-4. Some hard disks are formatted at the factory and do not require this
formatting procedure. Check the documentation that came with your hard
disk to see if the disk needs formatting.

This procedure formats all SCSI hard disks connected to the printer so the
disks are usable with the PostScript Level 2 Phaser 540 printer. The
formatting process erases all information already on the disk; be sure you want
the disk formatted before you use this procedure. If you have a disk
containing information you want to keep, such as fonts, turn off all devices,
then disconnect the disk from the printer before using this file to format
other disks.

Note  For additional information on SCSI hard disks, request a
document catalog from HAL or EuroHAL, the Tektronix
automated fax systems. Refer to page 9-2 for details on using
these systems.

Use one of the following files depending on your computer type.

Macintosh file name PC file name

Format Printer Disk FRMTDISK.PS

Note  Once you start the formatting procedure, there is no way to cancel
the formatting process.
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Using SCSI Hard Disks B

Macintosh users

1.

If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

Double-click on the LaserWriter Utility icon.

Select Download PostScript File from the Utilities menu.

Select the Format Printer Disk file in the folder on your hard disk
containing decompressed utility files and click Open.

At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Then click Save
to send the file to the printer.

If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the dialog box.

PC and workstation users

Locate the FRMTDISK.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

1.

Copy the file to your hard disk, or use the file from the diskette.

Use one of the following methods to send the file to the printer:

PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

Workstation users: Send the file to the printer as you would any
PostScript file.
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Initializing a formatted SCSI hard disk

Use this procedure to initialize a formatted SCSI hard disk connected to the
printer. Use one of the following files depending on your computer type.

B-4

Macintosh file name PC file name

LaserWriter Utility INITDISK.PS

Macintosh users

1.

If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility file in the folder on your hard disk
containing decompressed utility files.

Double-click the LaserWriter Utility icon.

Choose Initialize Printer’s Disk from the File menu. (This
option is grayed out (unavailable) if no SCSI disk is connected
to the printer.)

Select the file name; then click Open.

PC and workstation users

1.

Locate the INITDISK.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

Copy the file to your hard disk, or use the file from the diskette.
Use one of the following methods to send the file to the printer:

= PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Enabling and disabling SysStart Job execution

Send one of these files to the printer to control SysStart Job execution.

Macintosh file name PC file name
Set SysStart Job SYSTART.PS
No SysStart Job NOSYSTRT.PS
Note  You can also control SysStart Job execution from the printer’s

front panel using the Startup Mode option in the Printer
Defaults menu.

The Set SysStart Job (SYSTART.PS) file enables automatic execution
of a file named SysStart (if one is found) on a hard disk connected
to the printer’s SCSI port, each time the printer is turned on or
reset. The SysStart job is similar to an Init file; it executes
automatically each time the printer is turned on.

The No SysStart Job (NOSYSTRT.PS) file disables automatic
execution of the SysStart job.

Macintosh users

1.

If you have not decompressed the Phaser 540 Utilities.sea archive
file on the Macintosh Driver and Printer Utilities diskette, follow
the instructions on page 2-11 to decompress this file.

Select the appropriate printer in the Chooser.

Locate the LaserWriter Utility in the folder on your hard disk
containing decompressed utility files.

Double-click on the LaserWriter Utility icon.

Select Download PostScript File from the Utilities menu.
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B Using SCSI Hard Disks

6. Select the Set SysStart Job or No SysStart Job file in the folder
on your hard disk containing decompressed utility files and
click Open.

7. At the Save PostScript output as: prompt, you are asked
to supply a file name for saving printer output. Use the default
name given in the edit box or type in a new name. Then click Save
to send the file to the printer.

8. If no output is returned by the printer, the LaserWriter Utility
displays a dialog box. Click OK in the dialog box.

PC and workstation users

1. Locate the SYSTART.PS and NOSYSTRT.PS files in the PHSR540
directory on the Tektronix Windows 3.1 Driver and Printer
Utilities diskette.

2. Copy the files to your hard disk, or use the files from the diskette.

3. Use one of the following methods to send the desired file to the
printer:

= PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Appendix

Using Different Printer
Language Modes

This appendix is for PC or workstation users who want to use PostScript,
HP-GL (Hewlett-Packard’s Graphics Language), or monochrome PCL5
(Printer Command Language) printer languages. It explains how to perform
the following tasks:

= Setting PostScript and HP-GL timeouts

Changing printer language modes

Testing printer language mode changes

Setting default HP-GL pen colors
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C Using Different Printer Language Modes

Setting PostScript and HP-GL job and wait timeouts

C-2

Note  The HP-GL job timeout is the same as the PostScript job timeout.

The CONFIG.PS file changes the PostScript and HP-GL job and wait timeout
values. Changes are persistent across print jobs but not across printer
power cycles.

= The wait timeout is the amount of time in seconds that the printer
waits for data to come from the computer during a job. If the data
stream pauses for longer than the specified number of seconds, a
timeout error is generated and the job is cancelled.

= The job timeout is the amount of time any single job may be active
before it must print.

= In PostScript mode, if the value is exceeded, a timeout error is
generated.

= In HP-GL mode, if the timeout value is too small, an image may be
split across two pages; if the value is too large, multiple-page prints
may be combined on one page.

Note  This file affects printer operation. If the printer is shared on a
network, using this file may affect the prints requested from
other users.

1. Configure the printer port to receive PostScript.

2. Locate the CONFIG.PS file in the PHSR540 directory on the
Tektronix Windows 3.1 Driver and Printer Utilities diskette.

3. The default values for the printer are 0 seconds for the job timeout

and 40 seconds for the wait timeout. A timeout value of 0
indicates no timeout; the printer waits indefinitely.
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Using Different Printer Language Modes C

To change CONFIG.PS to specify different timeouts, substitute
new values for 0, 40, and 60 in the JobTimeOut, WaitTimeOut,
and ManualFeedTimeout lines. Permitted timeout values are as
follows:

= JobTimeOut: 0to 999

= WaitTimeOut: 0, or 15 to 999

= ManualFeedTimeOut: 0to 999
= To specify no timeout, use 0

In the following example, the timeouts are set to their
default values.

3 dict begin
/Password () def
/{JobTimeOut 0 def
/WaitTimeOut 40 def
currentdict end setsystemparams
1 dict begin
currentpagedevice /ManualFeedTimeout known
{ /ManualFeedTimeout 60 def } if
currentdict end setpagedevice

4. Use one of the following methods to send the file to the printer:
= PC users: Use the DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page 3-20
and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Changing printer language modes

The printer supports the following printer languages:

s PostScript Level 1 and Level 2

= HP-GL (Hewlett-Packard Graphics Language)

= Monochrome PCL5 (Printer Command Language)

In the factory default configuration, the printer expects to receive PostScript
data on all ports. To use an HP-GL application, you must explicitly set up a
printer port for HP-GL data, or enable Adobe IntelliSellect™ automatic
language selection. To use a PCL5 application, you must enable automatic
language selection on a port.

Changing the language of the printer between PostScript, HP-GL, and PCL5
is port-specific. The ports, such as parallel, serial, or LocalTalk, can each be
configured differently. You can change the default language on any port so
whenever the printer is turned on it expects to receive PostScript, HP-GL, or
PCL5 data on a specific port. If automatic language selection is enabled on a
particular port, it becomes the default on that port, allowing you to change
back and forth between PostScript, HP-GL, and PCL5.

Changes to the language on any port are persistent across print jobs and
across printer power cycles.

Note  The following files affect printer operation. If the printer is shared
on a network, using these files may affect the prints requested
from other users.

= To print PostScript files, use the PSCRIPT.PS file to set up a port to
receive PostScript.

= To print HP-GL files, use the HPGL.PS file to set up a port to
receive HP-GL.

= To print PCL5 files, use the AIS.PS file to set up a port for
automatic language selection.
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Printing PostScript files

The PSCRIPT.PS file changes a port to accept only PostScript data. After you
copy this file to a port, the printer expects PostScript files on that port. The
port’s language change is persistent across print jobs and across printer
power cycles.

= To use, send the PSCRIPT.PS file to the printer.

Printing HP-GL files

The HPGL.PS file changes a port to accept only HP-GL data. After you copy
this file to a port, the printer expects HP-GL files on that port. The port’s
language change is persistent across print jobs and across printer power
cycles.

= To use, send the HPGL.PS file to the printer.

Printing PCL5 files

The AIS.PS file changes a port to automatic language selection. After you
copy this file to a port, the printer will accept monochrome PCLS5, or
PostScript, or HP-GL files on that port. The port’s language change is
persistent across print jobs and across printer power cycles.

= To use, send the AIS.PS file to the printer.
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Testing printer language mode changes

HP-GL mode
HPGLTEST.PLT is an HP-GL file that prints a single line of text if the printer
is operating in HP-GL mode.
Use one of the following methods to send the HPGLTEST.PLT file to the
printer after you send HPGL.PS to make sure the change was made
correctly:
s PCusers: Usethe DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page
3-20 and page 3-21 for details.
= Workstation users: Send the file to the printer.
PostScript mode

PSTEST.PS is a PostScript file that prints a single line of text if the printer is
operating in PostScript mode.

Use one of the following methods to send the PSTEST.PS file to the printer
after you send PSCRIPT.PS to make sure the change was made correctly:

s  PCusers: Usethe DOS COPY command or the Copy command in
Windows File Manager to send the file to the printer. See page
3-20 and page 3-21 for details.

= Workstation users: Send the file to the printer as you would any
PostScript file.
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Setting default HP-GL pen colors

The HPGLPENS.PS file changes the color and width of the default pen
colors. The HP 7475A plotter actually has only six pens, but the printer’s
emulation supports up to 256 pens.

Note  HP-GL pen settings cannot be made persistent across power
cycles; pen settings revert to the default when the printer is
turned off.

In HPGLPENS.PS, pen number, pen width, red value, green value, and blue
value are listed in parentheses after /ColorSetup as shown below.

/ColorSetup ( pen_number width red_value green_value
blue_value...)

In the example below, all pen widths are set to 0.35 millimeters. Pen 0 is
white (this is the background pen color), pen 1 is black, pen 2 is red, pen 3 is
green, pen 4 is blue, pen 5 is cyan, pen 6 is magenta, and pen 7 is yellow.

The pen color change is persistent across jobs, but not across printer power
cycles; it affects all HP-GL jobs that immediately follow it until the next
printer reset.

Note  This file affects printer operation. If the printer is shared on a
network, using this file may affect the prints requested from
other users.

CTRL-D
(Y%HP7475A%) << /Password ()
/ColorSetup (0 0.351.01.01.0
10.350.00.00.0
20.351.00.00.0
30.350.01.00.0
40.350.00.01.0
50.350.01.01.0
60.351.00.01.0
70.351.01.00.0)
>> setdevparams
CTRL-D
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Allowable values for pen numbers are 0 through 255. Pen width is
measured in millimeters. Red, green, and blue values can be any number
between 0.0 and 1.0. The following table shows the red, green, and blue
combinations for each of the eight basic colors.

HP-GL pen color values

Color Red value Green value Blue value
red 1.0 0.0 0.0
green 0.0 1.0 0.0
blue 0.0 0.0 1.0
yellow 1.0 1.0 0.0
magenta 1.0 0.0 1.0
cyan 0.0 1.0 1.0
white 1.0 1.0 1.0
black 0.0 0.0 0.0

To add a new pen, you must redefine pens 0 through 7 first, then add the
new pens that you want.

To set pen widths and colors to values other than those in HPGLPENS.PS, do
the following:

1. Configure the printer port to receive PostScript; see page C-5.

2. Edit the file and substitute the values that you want for those in
the file. Color values can be any decimal number between 0.0
and 1.0.

For example, to change pen 4 to a purple color and a width of
.5 mm, edit HPGLPENS.PS and change the line for pen number 4
to the following:

4051.00.005
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Index

A
addctrld, UNIX shell script 4-5
ADDCTRLD.BAT, PC utility file 3-25
adjusting printed colors 6-1
adjusting to print a truer blue 6-8
Adobe Illustrator, PANTONE color library file
Macintosh 2-21
PC 3-29
AIS.PS, PC utility file C-5
Aldus FreeHand, PANTONE color library file
Macintosh 2-22, 2-24
PC 3-30
Aldus PageMaker, PANTONE color library file
Macintosh 2-24
PC 3-31
ANYTRAY.PS, PC utility file 5-7
AppleTalk Network Software, upgrading 9-8
applications, printing from
Macintosh 2-16 to 2-24
PC 3-26 to 3-32
automated fax systems 9-2

B
BBS 9-1
before you begin 1-1
BIDIR.PS, PC utility file A-14
bi-directional status reporting
disabling A-14
enabling A-14
blue color adjustment 6-8
Bulletin Board Service 9-1

C

Canvas (Macintosh), printer
description files 2-18
changing the printer’s name
Macintosh 2-15
PC 3-23
workstation 3-23
CIE colors 6-1
CMYK Sampler, Macintosh utility file 6-12
CMYK.PS, PC utility file 6-12
color charts
CMYK 6-13
HSB 6-13
PANTONE 6-17
printing 6-12 to 6-18
RGB 6-13
color corrections
from an application 6-5
monochrome or gray scale 6-10
no corrections 6-8
selecting 6-4 to 6-11
simple conversions 6-11
simulate display 6-8
simulate printing press 6-9
use printer setting 6-10
vivid color 6-8
colors
adjusting or correcting 6-1, 9-16
guidelines for using 6-2 to 6-3
commands, DOS
COPY command, using 3-20
MODE command, using 3-19
Commercial Press, Tektronix driver setting 6-9
communication ports 3-6
CONFIG.PS, PC utility file C-2
configuration page
printing (Macintosh) A-4
printing (PC) A-4
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Configuration Page, Macintosh utility file A-4
configuring

serial ports (PC) A-11 to A-14

Windows printer driver 3-5 to 3-8
Control Startpage files

Macintosh A-2

PC A-2
Control-D

PC utility files 3-25

workstation 4-4
COPY command, using 3-20
CoreIDRAW!, PANTONE Color

library file (PC) 3-32

correcting printed colors 6-1
creating a desktop printer 8-3
CTRLD.PS, PC utility file 3-25
customer support 9-1

D

decompressing Macintosh utility files 2-11
default desktop printer, setting with
QuickDraw GX driver 8-8

delctrld, UNIX shell script 4-5
desktop printers

creating 8-3

printing from 8-6

settingup 8-5
DEVPARAM.PS, PC utility file A-11, A-14
diskettes

contents 1-4

locating 1-1

mounting on a workstation 4-6 to 4-8
display colors, simulating 6-8
DOS

COPY command, using 3-20

printing from 3-19

Index-2 Phaser 540 Drivers and Utilities

downloading
files from Tektronix over the Internet 9-6
fonts (Macintosh) 7-3
fonts (PC) 7-6

downloading PostScript files
from a workstation 4-1
from DOS 3-20
from QuickDraw GX driver 8-11, 8-13
from Windows 3-21

drivers
Macintosh printer driver 1-2
QuickDraw GX driver 8-1
when to use 1-2
Windows NT printer driver 3-16
Windows printer driver 1-2

drivers, utility files, and front panel 1-2

E

enhanced print quality 5-10

Enhanced Quality, Macintosh utility file 5-11
ENHANCED.PS, PC utility file 5-11

error handlers, PostScript 9-9

EtherTalk printer name 2-15, 3-23
Euroscale Press, Tektronix driver setting 6-9
Extension Setup command 8-9

F
fast print quality 5-10
Fast Quality, Macintosh utility file 5-11
FAST.PS, PC utility file 5-11
fax systems, information 9-2
files, utility See Macintosh utility files and PC
utility files.
font sampler
printing (Macintosh) 7-4
printing (PC) 7-6
Font Sampler, Macintosh utility file 7-4



fonts
decompressing (Macintosh) 7-2
downloading (Macintosh) 7-3
downloading (PC) 7-6
installing (Macintosh) 7-2
Macintosh 7-1 to 7-4
Windows 7-5 to 7-6
FONTS.PS, PC utility file 7-6
Format Printer Disk, Macintosh utility file B-2
format SCSI hard disk B-2
FreeHand
printer description files
(Macintosh) 2-18 to 2-19
printer description files (PC) 3-27
FRMTDISK.PS, PC utility file B-2
front panel
interactions with drivers and utility files 1-2
when to use 1-3
front panel menus
disabling A-9
enabling A-9

H

HAL 4-2
halftone screens 9-17
hard disk, SCSI

formatting B-2

initializing B-4

selecting B-1
help, Windows printer driver 3-2
HP-GL language C-4
HP-GL pen colors C-7
HPGL.PS, PC utility file C-5
HPGLPENS.PS, PC utility file C-7
HPGLTEST.PLT, PC utility file C-6
HSB.PS, PC utility file 6-12

image orientation 5-12
information server 9-6
initializing a SCSI hard disk B-4
INITDISK.PS, PC utility file B-4
Input Trays command 8-9
input trays, controlling with
QuickDraw GX driver 8-9
installing
Macintosh printer driver 2-2
QuickDraw GX driver 8-2
Windows printer driver on a
computer 3-3 to 3-4
Windows printer driver on a network 3-12
to 3-13
Internet, downloading Tektronix files from 9-6
introductory information 1-1

J
job timeout C-2

L

landscape orientation 5-12
language modes

checking 9-14

HP-GL C-4

PCL5 C-4

PostScript C-4

testing mode changes C-6
LaserWriter 8.x driver, using 2-7 to 2-9
LaserWriter Utility, Macintosh utility file 2-12
LocalTalk printer name 2-15, 3-23
LOWRTRAY.PS, PC utility file 5-7
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Macintosh printer driver

extensions to Print dialog box 2-4
installing 2-2

locating the software 1-2

media sizes 5-2

media trays 5-7

Page Setup dialog box 2-5

Print dialog box 2-5

selecting printer in Chooser 2-3
system requirements 2-2
TekColor Options dialog box 2-6
using 2-4

Macintosh READ ME files, reading 9-24
Macintosh screen fonts

decompressing 7-2
installing 7-2

Macintosh utility files

CMYK Sampler 6-12
Configuration Page A-4
decompressing 2-11
Enhanced Quality 5-11
Fast Quality 5-11

Font Sampler 7-4
Format Printer Disk B-2
LaserWriter Utility 2-12
locating the software 1-2
Menu Long A-9

Menu Short A-9

No SysStart Job B-5

PANTONE-Tek Phaser 540 6-12, 6-17

printer description files 2-16 to 2-24
Raw CMYK Colors 6-11

Raw RGB Colors 6-11

Reset Printer 9-22

RGB Sampler 6-12

sending to the printer 2-12 to 2-13
Set SysStart Job B-5

Index-4 Phaser 540 Drivers and Utilities

Setscreen Patch 9-17

Standard Quality 5-11

Tek Error Handler 9-9

Use Any Tray 5-7

Use Lower Tray 5-7

Use Middle Tray 5-7

Use Upper Tray 5-7

using 2-10 to 2-15
making the best color prints 1-1
manual feed printing 5-9
media sizes, selecting 5-2 to 5-4
media trays

problems using the trays 9-24

selecting 5-5 to 5-7
mediad daemon 4-6
Menu Long, Macintosh utility file A-9
Menu Short, Macintosh utility file A-9
MENULONG.PS, PC utility file A-9
MENUSHRT.PS, PC utility file A-9
Microsoft Windows NT PostScript printer

driver, updating 3-16 to 3-18
Microsoft Windows PostScript driver,
updating 3-14 to 3-15

MIDDTRAY.PS, PC utility file 5-7
Monochrome, Tektronix driver setting 6-10
mounting a PC diskette 4-6 to 4-8
msdosd daemon 4-6

N

network printing 9-20

NFS, see PC/NFS 3-8

No SysStart Job, Macintosh utility file B-5
None, Tektronix driver setting 6-8
NOSYSTRT.PS, PC utility file B-5

NT, Windows NT PostScript printer driver 3-16



O

Options dialog box, Windows 3-10
orientation, image 5-12

Output Face Up, Tektronix driver setting 5-14
output order 5-14

P

Page Setup dialog box, Macintosh 2-5
page sizes, see media sizes, selecting
PageMaker
printer description files
(Macintosh) 2-18 to 2-19
printer description files (PC) 3-27
PANT540.PS, PC utility file 6-17
PANTONE printer files
Adobe lllustrator
Macintosh 2-21
PC 3-29
Aldus FreeHand
Macintosh 2-22, 2-24
PC 3-30
Aldus PageMaker
Macintosh 2-24
PC 3-31
color charts 6-17
CorelIDRAW! (PC) 3-32
PANTONE-Tek Phaser 540, Macintosh utility
file 6-12, 6-17
Paper Match printing extension,
QuickDraw GX driver 8-20
paper sizes, see media sizes
paper trays, see media trays
PC DOS, printing from 3-19
PC utility files
ADDCTRLD.BAT 3-25
AIS.PS C-5
ANYTRAY.PS 5-7
BIDIR.PS A-14

CMYK.PS 6-12
CONFIG.PS C-2
CTRLD.PS 3-25
DEVPARAM.PS A-11, A-14
ENHANCED.PS 5-11
FAST.PS 5-11
FONTS.PS 7-6
FRMTDISK.PS B-2
HPGL.PS C-5
HPGLPENS.PS C-7
HPGLTEST.PLT C-6
HSB.PS 6-12
INITDISK.PS B-4
locating the software 1-2
LOWRTRAY.PS 5-7
MENULONG.PS A-9
MENUSHRT.PS A-9
MIDDTRAY.PS 5-7
NOSYSTRT.PS B-5
PANT540.PS 6-17
PRNTCNFG.PS A-4
PRNTNAME.PS 3-23
PSCRIPT.PS C-5
PSTEST.PS C-6
RAWCMYK.PS 6-11
RAWRGB.PS 6-11
RESET.PS 9-22
RGB.PS 6-12
SETNOSPG.PS A-2
SETSCRN.PS 9-17
SETSTPG.PS A-2
STANDARD.PS 5-11
SYSTART.PS B-5
TEKEHAND.PS 9-9
UNIDIR.PS A-14
UPPRTRAY.PC 5-7
using 3-20

PC/NFS 3-8
PCL5 language C-4
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PDF files, using
Macintosh 2-20
Windows 3-28
PDX files, using
Macintosh 2-18
PC 3-27
pen colors, HP-GL C-7
Phaser Print software 4-2
portrait orientation 5-12
ports, see communication ports
PostScript
errors 9-8
printing errors 9-7
timeout C-2
PostScript files
downloading from a workstation 4-1
downloading from DOS 3-20
downloading from Windows 3-21
PostScript language C-4
PostScript Level 2 1-2
PostScript printer driver (Windows),
updating 3-14 to 3-15
PPD 3.0 files, using
Macintosh 2-18
PC 3-27
PPD 4.1 files, using
Macintosh 2-19
PC 3-27
Print dialog box
Macintosh 2-5
QuickDraw GX driver 8-19
print quality, selecting 5-10 to 5-11
Enhanced 5-10
Fast 5-10
Standard 5-10
print speed, improving 9-11

Index-6 Phaser 540 Drivers and Utilities

printer
renaming 2-15
resetting 9-22
selecting in Chooser 2-3
printer description files
Aldus FreeHand (Macintosh) 2-18 to 2-19
Aldus FreeHand (PC) 3-27
Aldus PageMaker (Macintosh) 2-18 to 2-19
Aldus PageMaker (PC) 3-27
Canvas 2-18
Macintosh 2-16 to 2-24
PC 3-26 to 3-32
QuarkXPress (Macintosh) 2-20
QuarkXPress (PC) 3-28
Printer Setup dialog box, Windows 3-9
printer status
viewing for QuickDraw GX driver 8-23
Printer Status dialog box, QuickDraw GX
driver 8-23
Printer Utilities command 8-11
PRINTER.INF, updating Windows NT
driver 3-16
printing a configuration page
Macintosh A-4
PC A4
printing on a network 9-20
printing press color corrections 6-9
printing problems 9-12
PRNTCNFG.PS, PC utility file A-4
PRNTNAME.PS, PC utility file 3-23
PSCRIPT.PS, PC utility file C-5
PSTEST.PS, PC utility file C-6
PSTEST.PS, PC utility file C-6



Q
QuarkXPress
printer description files (Macintosh) 2-20
printer description files (PC) 3-28
QuickDraw GX driver
controlling input trays 8-9
controlling printing 8-7
creating a desktop printer 8-3
downloading PostScript files 8-13
downloading utility files 8-11
enabling third-party printing extensions 8-9
printing from non-QuickDraw GX
applications 8-21 to 8-22
printing from QuickDraw GX
applications 8-16 to 8-20
Printing menu 8-7
setting a default desktop printer 8-8
setting up desktop printers 8-5
system requirements 8-1
QuickDraw GX, disabling 8-22

R

Raw CMYK Colors, Macintosh utility file 6-11
Raw RGB Colors, Macintosh utility file 6-11
RAWCMYK.PS, PC utility file 6-11
RAWRGB.PS, PC utility file 6-11
READ ME files, Macintosh, reading 9-24
renaming the printer

Macintosh 2-15

PC 3-23

workstation 3-23
Reset Printer, Macintosh utility file 9-22
RESET.PS, PC utility file 9-22
resetting the printer 9-22
RGB Sampler, Macintosh utility file 6-12
RGB.PS, PC utility file 6-12

S
screen fonts, Macintosh 7-1 to 7-4
SCSI hard disk
formatting B-2
initializing B-4
selecting B-1
selecting
color corrections 6-4 to 6-11
media sizes (Macintosh) 5-3
media sizes (PC) 5-4
media trays 5-5 to 5-7
print quality 5-10 to 5-11
stack order 5-14
serial port, configuring (PC) A-11 to A-14
Set Default Printer command 8-8
Set SysStart Job, Macintosh utility file B-5
SETNOSPG.PS, PC utility file A-2
Setscreen Patch, Macintosh utility file 9-17
SETSCRN.PS, PC utility file 9-17
SETSTPG.PS, PC utility file A-2
setting up desktop printers 8-5
shared printers
QuickDraw GX driver 8-14 to 8-15
settingup 8-14
using 8-15
simple color conversions 6-11
Simulate Display, Tektronix driver setting 6-8
simulating display colors 6-8
speed, improving print speed 9-11
stack order 5-14
standard print quality 5-10
Standard Quiality, Macintosh utility file 5-11
STANDARD.PS, PC utility file 5-11
Start Print Queue command 8-7
starting printing, QuickDraw GX driver 8-7
Startup page, enable or disable
Macintosh A-2
PC A-2
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Stop Print Queue command 8-7

stopping printing, QuickDraw GX driver 8-7
support, customer 9-1

SWOP Press, Tektronix driver setting 6-9
SysStart Job files, using B-5

SYSTART.PS, PC utility file B-5

T

technical support 9-1
Tek Error Handler, Macintosh utility file 9-9
TekColor Dynamic Correction 6-1
TekColor Options dialog box, Macintosh 2-6
TekColor printing extension, QuickDraw GX
driver 8-20
TEKEHAND.PS, PC utility file 9-9
Tektronix Bulletin Board Service 9-1
Tektronix information server 9-6
Tektronix Printer Features dialog box,
Windows 3-11
timeouts
job C-2
resolving in Windows 9-15
wait C-2
Windows printer driver 3-7
Transmission Retry, Windows 3-7
transparency trays, see media trays
troubleshooting 9-2
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U
UNIDIR.PS, PC utility file A-14
UNIX shell scripts
addctrld 4-5
delctrld 4-5
updating
Microsoft Windows NT PostScript
driver 3-16 to 3-18
standard Microsoft Windows PostScript
driver 3-14 to 3-15
Windows NT PostScript driver 3-16
upgrading AppleTalk Network Software 9-8
UPPRTRAY.PS, PC utility file 5-7
Use Any Tray, Macintosh utility file 5-7
Use Lower Tray, Macintosh utility file 5-7
Use Middle Tray, Macintosh utility file 5-7
Use PostScript Level 2 Features, Tektronix driver
setting 3-7
Use Printer Setting, Tektronix driver
setting 6-10
Use Upper Tray, Macintosh utility file 5-7
using the printer 1-2
using utility files
Macintosh 2-10 to 2-15
PC 3-20 to A-14
utility file and driver interactions 1-2
utility files
locating the software 1-2
Macintosh
decompressing 2-11
sending files to the printer 2-12 to 2-13
using 2-10 to 2-15
PC
sending files to the printer 3-20 to 3-21
using 3-20 to 3-32
using 1-2
workstation
sending files to the printer 4-1



vV
Vivid Color, Tektronix driver setting 6-8

W
wait timeout C-2
WINL.INI file, editing 7-5
Windows NT printer driver, updating 3-16
Windows printer driver
configuring 3-5 to 3-8
installing on a computer 3-3 to 3-4
installing on a network 3-12 to 3-13
locating the software 1-2
media sizes 5-2
media trays 5-7
on-line help 3-2
Options dialog box 3-10
Printer Setup dialog box 3-9
system requirements 3-1
Tektronix Printer Features dialog box 3-11
timeouts 3-7
using 3-9 to 3-13
using fonts 7-5 to 7-6
workstations
Phaser Print software 4-2
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